Applied Biosystems StepOne™
and StepOnePlus™
Real-Time PCR Systems
Genotyping Experiments
Applied Biosystems StepOne™
and StepOnePlus™
Real-Time PCR Systems
Genotyping Experiments
## Preface

- How to Use This Guide: v
- How to Obtain More Information: vii
- How to Obtain Support: xi
- Safety Conventions Used in This Document: xii
- Symbols on Instruments: xiii
- Safety Labels on Instruments: xv
- General Instrument Safety: xvi
- Chemical Safety: xvii
- Chemical Waste Safety: xviii
- Electrical Safety: xix
- LED Safety: xx
- Biological Hazard Safety: xx
- Workstation Safety: xxi
- Safety and Electromagnetic Compatibility (EMC) Standards: xxi

### Chapter 1
**Get Started.**

- About the StepOne™ and StepOnePlus™ Systems: 1
- Supported Consumables: 2
- About Genotyping Experiments: 4
- How to Use This Guide: 9
- About the Example Experiment: 10
- Example Experiment Workflow: 13

### Chapter 2
**Design the Experiment**

- Chapter Overview: 15
- Create a New Experiment: 16
- Define the Experiment Properties: 17
- Define the Methods and Materials: 19
- Set Up the SNP Assays: 21
- Set Up the Samples and Replicates: 23
- Set Up the Run Method: 25
- Review the Reaction Setup: 27
- Order Materials for the Experiment: 29
- Finish the Design Wizard: 32
<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>Prepare the Reactions</th>
<th>37</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Chapter Overview</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Prepare the Sample Dilutions</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Prepare the Reaction Mix</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Prepare the Reaction Plate</td>
<td>42</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Run the Experiment</th>
<th>47</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Chapter Overview</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Prepare for the Run</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>(Optional) Enable the Notification Settings</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>Start the Run</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Monitor the Run</td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>Unload the Instrument and Transfer the Data</td>
<td>65</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Analyze the Experiment</th>
<th>69</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Chapter Overview</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Open the Experiment for the Analysis</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>View the Allelic Discrimination Plot</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>View the Plate Layout</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>View the Well Table</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>View the QC Summary</td>
<td>81</td>
</tr>
<tr>
<td></td>
<td>View the Raw Data Plot</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>View the Multicomponent Plot</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>View the Amplification Plot</td>
<td>86</td>
</tr>
<tr>
<td></td>
<td>View the Analysis Settings</td>
<td>93</td>
</tr>
<tr>
<td></td>
<td>Publish the Data</td>
<td>98</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix A</th>
<th>Alternate Experiment Workflows</th>
<th>99</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Advanced Setup Workflow</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>QuickStart Workflow</td>
<td>101</td>
</tr>
<tr>
<td></td>
<td>Template Workflow</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>Export/Import Workflow</td>
<td>105</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bibliography</th>
<th>109</th>
</tr>
</thead>
</table>

| Glossary | 111 |

| Index | 127 |
How to Use This Guide

**About the System Documentation**

The guides listed below are shipped with the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

<table>
<thead>
<tr>
<th>Guide</th>
<th>Purpose and Audience</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td>Explains how to perform experiments on the StepOne and StepOnePlus systems. Each Getting Started Guide functions as both:</td>
<td>4376786</td>
</tr>
<tr>
<td>Getting Started Guide for Genotyping Experiments</td>
<td>• A tutorial, using example experiment data provided with the Applied Biosystems StepOne™ Real-Time PCR Software (StepOne™ software).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A guide for your own experiments.</td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td>Intended for laboratory staff and principal investigators who perform experiments using the StepOne or StepOnePlus system.</td>
<td>4376787</td>
</tr>
<tr>
<td>Getting Started Guide for Presence/Absence Experiments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td>Explains how to install and maintain the StepOne and StepOnePlus systems.</td>
<td>4376782</td>
</tr>
<tr>
<td>Getting Started Guide for Relative Standard Curve and Comparative C_T</td>
<td>Intended for laboratory staff responsible for the installation and maintenance of the StepOne or StepOnePlus system</td>
<td></td>
</tr>
<tr>
<td>Experiments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td></td>
<td>4376785</td>
</tr>
<tr>
<td>Getting Started Guide for Standard Curve Experiments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems 7500/7500Fast, StepOne™, and StepOnePlus™ Real-Time</td>
<td></td>
<td>4411937</td>
</tr>
<tr>
<td>PCR Systems Quick Reference Card for Comparative C_T Experiments and</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Studies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td></td>
<td>4376783</td>
</tr>
<tr>
<td>Installation, Networking, and Maintenance Guide</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### How to Use This Guide

**Assumptions**

This guide assumes that you:

- Are familiar with the Microsoft Windows® XP operating system.
- Are familiar with the Internet and Internet browsers.
- Know how to handle DNA and/or RNA samples and prepare them for PCR.
- Understand data storage, file transfer, and copying and pasting.
- Have networking experience, if you plan to integrate the StepOne or StepOnePlus system into your existing laboratory data flow.

**Text Conventions**

This guide uses the following conventions:

- **Bold** text indicates user action. For example:
  
  Type 0, then press **Enter** for each of the remaining fields.

- **Italic** text indicates new or important words and is also used for emphasis.
  
  For example:
  
  Before analyzing, *always* prepare fresh matrix.

- A right arrow symbol (→) separates successive commands you select from a drop-down or shortcut menu. For example:

  Select **File → Open**.

---

<table>
<thead>
<tr>
<th>Guide</th>
<th>Purpose and Audience</th>
<th>PN</th>
</tr>
</thead>
</table>
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide** | Provides information about the reagents you can use on the StepOne and StepOnePlus systems, including:  
  - An introduction to TaqMan® and SYBR® Green reagents  
  - Descriptions and design guidelines for the following experiment types:  
    - Quantitation experiments  
    - Genotyping experiments  
    - Presence/absence experiments  
  Intended for laboratory staff and principal investigators who perform experiments using the StepOne or StepOnePlus system. | 4379704 |
| **Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site Preparation Guide** | Explains how to prepare your site to receive and install the StepOne and StepOnePlus systems.  
  Intended for personnel who schedule, manage, and perform the tasks required to prepare your site for installation of the StepOne or StepOnePlus system. | 4376768 |
| **Applied Biosystems StepOne™ Real-Time PCR Software Help**          | Explains how to use the StepOne software to:  
  - Set up, run, and analyze experiments using the StepOne and StepOnePlus systems.  
  - Monitor networked StepOne and StepOnePlus instruments.  
  - Calibrate StepOne and StepOnePlus instruments.  
  - Verify the performance of StepOne and StepOnePlus instruments with an RNase P run.  
  Intended for:  
  - Laboratory staff and principal investigators who perform experiments using the StepOne or StepOnePlus system.  
  - Laboratory staff responsible for the installation and maintenance of the StepOne or StepOnePlus system. | NA     |
User Attention Words

Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

**Note:** – Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** – Provides information that is necessary for proper instrument operation, accurate reagent kit use, or safe use of a chemical.

Examples of the user attention words appear below:

**Note:** The Calibrate function is also available in the Control Console.

**IMPORTANT!** To verify your client connection, you need a valid user ID.

Safety Alert Words

Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page xii.

How to Obtain More Information

Related Documentation

Other StepOne and StepOnePlus System Documents

The documents listed in the table below are not shipped with the StepOne or StepOnePlus instrument.

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td>4376791</td>
</tr>
<tr>
<td>Installation Performance Verification Protocol</td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td>4376790</td>
</tr>
<tr>
<td>Installation Qualification-Operation Qualification Protocol</td>
<td></td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems</td>
<td>4376788</td>
</tr>
<tr>
<td>Planned Maintenance Protocol</td>
<td></td>
</tr>
</tbody>
</table>
Documents Related to Genotyping Experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allelic Discrimination Pre-Developed TaqMan® Assay Reagents Quick Reference Card</td>
<td>4312212</td>
</tr>
<tr>
<td>Custom TaqMan® Genomic Assays Protocol</td>
<td>4367671</td>
</tr>
<tr>
<td>Custom TaqMan® SNP Genotyping Assays Protocol</td>
<td>4334431</td>
</tr>
<tr>
<td>Ordering TaqMan® SNP Genotyping Assays Quick Reference Card</td>
<td>4374204</td>
</tr>
<tr>
<td>Performing a Custom TaqMan® SNP Genotyping Assay for 96-Well Plates Quick Reference Card</td>
<td>4371394</td>
</tr>
<tr>
<td>Performing a TaqMan® Drug Metabolism Genotyping Assay for 96-Well Plates Quick Reference Card</td>
<td>4367636</td>
</tr>
<tr>
<td>Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol</td>
<td>4312214</td>
</tr>
<tr>
<td>TaqMan® Drug Metabolism Genotyping Assays Protocol</td>
<td>4362038</td>
</tr>
<tr>
<td>TaqMan® SNP Genotyping Assays Protocol</td>
<td>4332856</td>
</tr>
</tbody>
</table>

Documents Related to Presence/Absence Experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs Protocol</td>
<td>4343586</td>
</tr>
<tr>
<td>NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue Protocol</td>
<td>4333959</td>
</tr>
<tr>
<td>PrepMan® Ultra Sample Preparation Reagent Protocol</td>
<td>4318925</td>
</tr>
</tbody>
</table>
## Documents Related to Relative Standard Curve and Comparative C<sub>T</sub> Experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05</td>
</tr>
<tr>
<td>Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol</td>
<td>4375575</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
</tbody>
</table>

## Documents Related to Standard Curve Experiments

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplification Efficiency of TaqMan® Gene Expression Assays Application Note</td>
<td>127AP05</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
</tbody>
</table>
### Documents Related to the Reagent Guide

<table>
<thead>
<tr>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol</em></td>
<td>4375575</td>
</tr>
<tr>
<td>Custom TaqMan® Gene Expression Assays Protocol</td>
<td>4334429</td>
</tr>
<tr>
<td>Custom TaqMan® Genomic Assays Protocol: Submission Guidelines</td>
<td>4367671</td>
</tr>
<tr>
<td>Custom TaqMan® SNP Genotyping Assays Protocol</td>
<td>4334431</td>
</tr>
<tr>
<td><em>Power SYBR® Green PCR Master Mix and RT-PCR Protocol</em></td>
<td>4367218</td>
</tr>
<tr>
<td>Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol</td>
<td>4312214</td>
</tr>
<tr>
<td>Primer Express® Software Version 3.0 Getting Started Guide</td>
<td>4362460</td>
</tr>
<tr>
<td>SYBR® Green PCR and RT-PCR Reagents Protocol</td>
<td>4304965</td>
</tr>
<tr>
<td>SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol</td>
<td>4310251</td>
</tr>
<tr>
<td>TaqMan® Drug Metabolism Genotyping Assays Protocol</td>
<td>4362038</td>
</tr>
<tr>
<td>TaqMan® Exogenous Internal Positive Control Reagents Protocol</td>
<td>4308335</td>
</tr>
<tr>
<td>TaqMan® Fast Universal PCR Master Mix (2X) Protocol</td>
<td>4351891</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Assays Protocol</td>
<td>4333458</td>
</tr>
<tr>
<td>TaqMan® Gene Expression Master Mix Protocol</td>
<td>4371135</td>
</tr>
<tr>
<td>TaqMan® Genotyping Master Mix Protocol</td>
<td>4371131</td>
</tr>
<tr>
<td>TaqMan® SNP Genotyping Assays Protocol</td>
<td>4332856</td>
</tr>
<tr>
<td>TaqMan® Universal PCR Master Mix Protocol</td>
<td>4304449</td>
</tr>
<tr>
<td>User Bulletin #2: Relative Quantitation of Gene Expression</td>
<td>4303859</td>
</tr>
<tr>
<td>Using TaqMan® Endogenous Control Assays to Select an Endogenous Control for Experimental Studies Application Note</td>
<td>127AP08</td>
</tr>
</tbody>
</table>

**Note:** For more documentation, see “How to Obtain Support” on page xi.

---

**Obtaining Information from the Software Help**

The StepOne Software Help describes how to use each feature of the user interface. Access the Help from within the software by doing one of the following:

- Press F1.
- Click on the toolbar.
- Select Help > StepOne Software Help.

To find topics of interest in the Help:

- Review the table of contents.
- Search for a specific topic.
- Search an alphabetized index.
Send Us Your Comments

Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and suggestions relating to documentation. To order documents, download PDF files, or for help with a technical question, go to http://www.appliedbiosystems.com, then click the link for Support. (See “How to Obtain Support” on page xi).

How to Obtain Support

For the latest services and support information for all locations, go to http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents
- Download PDF documents
- Obtain information about customer training
- Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule maintenance for your StepOne™ or StepOnePlus™ instrument (such as annual planned maintenance or temperature verification/calibration), contact the Applied Biosystems Care Center. To obtain a phone number for or to send an e-mail to the center, go to http://www.appliedbiosystems.com/support/contact.
Safety Conventions Used in This Document

Safety Alert Words

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below.

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, accurate reagent kit use, or safe use of a chemical.

⚠️ CAUTION – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠️ WARNING – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠️ DANGER – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments (see “Safety Symbols” on page xiv).
Examples

**IMPORTANT!** You must create a separate sample entry spreadsheet for each 96-well plate.

---

**CAUTION** CHEMICAL HAZARD. TaqMan® Universal PCR Master Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

---

**WARNING** PHYSICAL INJURY HAZARD. During instrument operation, the heated cover and sample block can reach temperatures in excess of 100 °C.

---

**DANGER** ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation. Never operate the system with the grounding conductor disconnected.

---

# Symbols on Instruments

## Electrical Symbols

The following table describes the electrical symbols that may be displayed on Applied Biosystems instruments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="On symbol" /></td>
<td>Indicates the On position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Off symbol" /></td>
<td>Indicates the Off position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Standby symbol" /></td>
<td>Indicates a standby switch by which the instrument is switched on to the Standby condition. Hazardous voltage may be present if this switch is on standby.</td>
</tr>
<tr>
<td><img src="image" alt="On/Off symbol" /></td>
<td>Indicates the On/Off position of a push-push main power switch.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Ground symbol" /></td>
<td>Indicates a terminal that may be connected to the signal ground reference of another instrument. This is not a protected ground terminal.</td>
</tr>
<tr>
<td><img src="image" alt="Protective ground symbol" /></td>
<td>Indicates a protective grounding terminal that must be connected to earth ground before any other electrical connections are made to the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Alternating current symbol" /></td>
<td>Indicates a terminal that can receive or supply alternating current or voltage.</td>
</tr>
<tr>
<td><img src="image" alt="Direct current symbol" /></td>
<td>Indicates a terminal that can receive or supply alternating or direct current or voltage.</td>
</tr>
</tbody>
</table>
Safety Symbols

The following table describes the safety symbols that may be displayed on Applied Biosystems instruments. Each symbol may appear by itself or with text that explains the relevant hazard (see “Safety Labels on Instruments” on page xv). These safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur in the text of this and other product-support documents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Indicates that you should consult the manual for further information and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Indicates the presence of moving parts and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>☢️</td>
<td>Indicates the presence of a hot surface or other high-temperature hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Indicates the presence of an electrical shock hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Indicates the presence of a laser inside the instrument and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>

Environmental Symbols

The following symbol applies to all Applied Biosystems electrical and electronic products placed on the European market after August 13, 2005.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚫⚠️</td>
<td>Do not dispose of this product as unsorted municipal waste. Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste electrical and electronic equipment (WEEE). European Union customers: Call your local Applied Biosystems Customer Service office for equipment pick-up and recycling. See <a href="http://www.appliedbiosystems.com">http://www.appliedbiosystems.com</a> for a list of customer service offices in the European Union.</td>
</tr>
</tbody>
</table>
Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on Applied Biosystems instruments in combination with the safety symbols described in the preceding section.

<table>
<thead>
<tr>
<th>English</th>
<th>Francais</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAUTION Hazardous chemicals. Read the Material Safety Data Sheets (MSDSs) before handling.</td>
<td>ATTENTION Produits chimiques dangereux. Lire les fiches techniques de sûreté de matériels avant la manipulation des produits.</td>
</tr>
<tr>
<td>CAUTION Hazardous waste. Refer to MSDS(s) and local regulations for handling and disposal.</td>
<td>ATTENTION Déchets dangereux. Lire les fiches techniques de sûreté de matériels et la régulation locale associées à la manipulation et l’élimination des déchets.</td>
</tr>
<tr>
<td>CAUTION Hot surface.</td>
<td>ATTENTION Surface brûlante.</td>
</tr>
<tr>
<td>DANGER High voltage.</td>
<td>DANGER Haute tension.</td>
</tr>
<tr>
<td>WARNING To reduce the chance of electrical shock, do not remove covers that require tool access. No user-serviceable parts are inside. Refer servicing to Applied Biosystems qualified service personnel.</td>
<td>AVERTISSEMENT Pour éviter les risques d’électrocution, ne pas retirer les capots dont l’ouverture nécessite l’utilisation d’outils. L’instrument ne contient aucune pièce réparable par l’utilisateur. Toute intervention doit être effectuée par le personnel de service qualifié de Applied Biosystems.</td>
</tr>
<tr>
<td>CAUTION Moving parts.</td>
<td>ATTENTION Parties mobiles.</td>
</tr>
<tr>
<td>DANGER Class 3B (III) visible and/or invisible LED radiation present when open and interlocks defeated. Avoid exposure to beam.</td>
<td>DANGER Rayonnement visible ou invisible d’un faisceau LED de Classe 3B (III) en cas d’ouverture et de neutralisation des dispositifs de sécurité. Evitez toute exposition au faisceau.</td>
</tr>
</tbody>
</table>

Locations of Warnings

The StepOne and StepOnePlus instruments contain a warning at the location shown below:
General Instrument Safety

**WARNING** PHYSICAL INJURY HAZARD. Using the instrument in a manner not specified by Applied Biosystems may result in personal injury or damage to the instrument.

**CAUTION** PHYSICAL INJURY HAZARD. The instrument is to be moved and positioned only by the personnel or vendor specified in the applicable site preparation guide. If you decide to lift or move the instrument after it has been installed, do not attempt to lift or move the instrument without the assistance of others, the use of appropriate moving equipment, and proper lifting techniques. Improper lifting can cause painful and permanent back injury. Depending on the weight, moving or lifting an instrument may require two or more persons.

**WARNING** Do not attempt to lift or move the computer or the monitor without the assistance of others. Depending on the weight of the computer and/or the monitor, moving them may require two or more people.

**Things to consider before lifting the computer and/or the monitor:**
- Make sure that you have a secure, comfortable grip on the computer or the monitor when lifting.
- Make sure that the path from where the object is to where it is being moved is clear of obstructions.
- Do not lift an object and twist your torso at the same time.
- Keep your spine in a good neutral position while lifting with your legs.
- Participants should coordinate lift and move intentions with each other before lifting and carrying.
- Instead of lifting the object from the packing box, carefully tilt the box on its side and hold it stationary while someone slides the contents out of the box.

**Operating the Instrument**
Ensure that anyone who operates the instrument has:
- Received instructions in both general safety practices for laboratories and specific safety practices for the instrument.
- Read and understood all applicable Material Safety Data Sheets (MSDSs). See “About MSDSs” on page xvii.

**Cleaning or Decontaminating the Instrument**
Before using a cleaning or decontamination method other than those recommended by the manufacturer, verify with the manufacturer that the proposed method will not damage the equipment.
Chemical Safety

Chemical Hazard Warning

⚠️ WARNING CHEMICAL HAZARD. Before handling any chemicals, refer to the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all relevant precautions.

⚠️ WARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About MSDSs” on page xvii.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For more safety guidelines, consult the MSDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For more safety guidelines, consult the MSDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the MSDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

About MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with shipments of hazardous chemicals to new customers. They also provide MSDSs with the first shipment of a hazardous chemical to a customer after an MSDS has been updated. MSDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to replace the appropriate MSDS in your files.

Obtaining MSDSs

The MSDS for any chemical supplied by Applied Biosystems is available to you free 24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:
   a. Type in the chemical name, part number, or other information that you expect to appear in the MSDS of interest.
   b. Select the language of your choice.
c. Click **Search**.

3. To view, download, or print the document of interest:
   a. Right-click the document title.
   b. Select:
      - **Open** – To view the document
      - **Save Target As** – To download a PDF version of the document to a destination that you choose
      - **Print Target** – To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search Results page:
   a. Select **Fax** or **Email** below the document title.
   b. Click **RETRIEVE DOCUMENTS** at the end of the document list.
   c. Enter the required information.
   d. Click **View/Deliver Selected Documents Now**.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the chemical manufacturer.

---

**Chemical Waste Safety**

**Chemical Waste Hazard**

⚠️ **CAUTION** HAZARDOUS WASTE. Refer to Material Safety Data Sheets and local regulations for handling and disposal.

⚠️ **WARNING** CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

⚠️ **WARNING** CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

**Chemical Waste Safety Guidelines**

To minimize the hazards of chemical waste:

- Read and understand the Material Safety Data Sheets (MSDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.
• Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
• Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For more safety guidelines, consult the MSDS.
• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For more safety guidelines, consult the MSDS.
• Handle chemical wastes in a fume hood.
• After emptying a waste container, seal it with the cap provided.
• Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.

**Waste Disposal**

If potentially hazardous waste is generated when you operate the instrument, you must:

• Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

**IMPORTANT!** Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

---

**Electrical Safety**

---

### Fuses

---

**WARNING** FIRE HAZARD. Improper fuses or high-voltage supply can damage the instrument wiring system and cause a fire. Before turning on the instrument, verify that the fuses are properly installed and that the instrument voltage matches the power supply in your laboratory.

---

**WARNING** FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with fuses of the type and rating specified for the instrument.
Power

**DANGER ELECTRICAL HAZARD.** Grounding circuit continuity is vital for the safe operation of equipment. Never operate equipment with the grounding conductor disconnected.

**DANGER ELECTRICAL HAZARD.** Use properly configured and approved line cords for the voltage supply in your facility.

**DANGER ELECTRICAL HAZARD.** Plug the instrument into a properly grounded receptacle with adequate current capacity.

Overvoltage Rating

The StepOne and StepOnePlus instruments have an installation (overvoltage) category of II, and they are classified as portable equipment.

LED Safety

To ensure safe LED operation:

- The system must be maintained by an Applied Biosystems Technical Representative.
- All instrument panels must be in place on the instrument while the instrument is operating. When all panels are installed, there is no detectable radiation present. If any panel is removed when the LED is operating (during service with safety interlocks disabled), you may be exposed to LED emissions in excess of the Class 3B rating.
- Do not remove safety labels or disable safety interlocks.

Biological Hazard Safety

**WARNING BIOHAZARD.** Biological samples such as tissues, body fluids, infectious agents, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective equipment, which includes but is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves. All work should be performed in properly equipped facilities using the appropriate safety equipment (for example, physical containment devices). Individuals should be trained according to applicable regulatory and company/institution requirements before working with potentially infectious materials. Read and follow the applicable guidelines and/or regulatory requirements in the following:

- U.S. Department of Health and Human Services guidelines published in *Biosafety in Microbiological and Biomedical Laboratories* (stock no. 017-040-00547-4; [http://bmbl.od.nih.gov](http://bmbl.od.nih.gov))
- Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR§1910.1030; [http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html](http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html)).
• Your company’s/institution’s Biosafety Program protocols for working with/handling potentially infectious materials.

More information about biohazard guidelines is available at:

http://www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral or relaxed working positions.

⚠️ CAUTION MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards are caused by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:
• Use equipment that comfortably supports you in neutral working positions and allows adequate accessibility to the keyboard, monitor, and mouse.
• Position the keyboard, mouse, and monitor to promote relaxed body and head postures.

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and Canadian Safety Standards

The StepOne and StepOnePlus instruments have been tested to and comply with standard:

UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

Canadian EMC Standard

This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial, Scientific, and Medical Radio Frequency Generators.”

European Safety and EMC Standards

Safety

This instrument meets European requirements for safety (Low Voltage Directive 2006/95/EC). This instrument has been tested to and complies with standards EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”
EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC Directive 2004/108/EC). This instrument has been tested to and complies with standard EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and Laboratory Use – EMC Requirements.”

Australian EMC Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
This chapter covers:

■ About the StepOne™ and StepOnePlus™ Systems ........................................ 2
■ Supported Consumables ................................................................. 4
■ About Genotyping Experiments ..................................................... 6
■ How to Use This Guide ................................................................. 9
■ About the Example Experiment .................................................... 10
■ Example Experiment Workflow ...................................................... 13

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing F1, clicking 🕵️ in the toolbar, or selecting Help › StepOne Software Help.
About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

<table>
<thead>
<tr>
<th>System</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems StepOne™ Real-Time PCR System (StepOne™ system)</td>
<td>• 48-well platform</td>
</tr>
<tr>
<td></td>
<td>• Three-color system</td>
</tr>
<tr>
<td>Applied Biosystems StepOnePlus™ Real-Time PCR System (StepOnePlus™ system)</td>
<td>• 96-well platform</td>
</tr>
<tr>
<td></td>
<td>• Four-color system</td>
</tr>
<tr>
<td></td>
<td>• VeriFlex™ sample blocks</td>
</tr>
</tbody>
</table>

The StepOne and StepOnePlus systems use fluorescent-based polymerase chain reaction (PCR) reagents to provide:

- Quantitative detection of target nucleic acid sequences (targets) using real-time analysis.
- Qualitative detection of targets using post-PCR (endpoint) analysis.
- Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs post-PCR).

About Data Collection

The StepOne and StepOnePlus systems collect raw fluorescence data at different points during a PCR, depending on the type of run that the instruments perform:

<table>
<thead>
<tr>
<th>Run Type</th>
<th>Data Collection Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time runs</td>
<td>Standard curve The instrument collects data following each extension step of the PCR.</td>
</tr>
<tr>
<td></td>
<td>Relative standard curve</td>
</tr>
<tr>
<td></td>
<td>Comparative $C_T$ ($\Delta \Delta C_T$)</td>
</tr>
<tr>
<td>Post-PCR (endpoint) runs</td>
<td>Genotyping The instrument collects data:</td>
</tr>
<tr>
<td></td>
<td>• Before the PCR (For presence/absence experiments, data collection before the PCR is optional, but recommended.)</td>
</tr>
<tr>
<td></td>
<td>• (Optional) During the PCR. The instrument can collect data during the run (real-time); collecting data during the run can be helpful for troubleshooting.</td>
</tr>
<tr>
<td></td>
<td>• After the PCR</td>
</tr>
<tr>
<td>Presence/absence</td>
<td></td>
</tr>
</tbody>
</table>

Regardless of the run type, a data collection point or read on the StepOne™ or StepOnePlus™ instrument consists of three phases:

1. **Excitation** – The instrument illuminates all wells of the reaction plate within the instrument, exciting the fluorophores in each reaction.

Notes
2. **Emission** – The instrument optics collect the residual fluorescence emitted from the wells of the reaction plate. The resulting image collected by the device consists only of light that corresponds to the range of emission wavelengths.

3. **Collection** – The instrument assembles a digital representation of the residual fluorescence collected over a fixed time interval. The StepOne™ software stores the raw fluorescent image for analysis.

After a run, the StepOne software uses calibration data (spatial, dye, and background) to determine the location and intensity of the fluorescent signals in each read, the dye associated with each fluorescent signal, and the significance of the signal.

**About the Filters**

The StepOne and StepOnePlus systems use the following filters:

<table>
<thead>
<tr>
<th>Filter</th>
<th>StepOne system</th>
<th>Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAM™ dye</td>
<td>SYBR® Green dye</td>
</tr>
<tr>
<td>2</td>
<td>JOE™ dye</td>
<td>VIC® dye</td>
</tr>
<tr>
<td>3</td>
<td>ROX™ dye</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter</th>
<th>StepOnePlus system</th>
<th>Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAM™ dye</td>
<td>SYBR® Green dye</td>
</tr>
<tr>
<td>2</td>
<td>JOE™ dye</td>
<td>VIC® dye</td>
</tr>
<tr>
<td>3</td>
<td>TAMRA™ dye</td>
<td>NED™ dye</td>
</tr>
<tr>
<td>4</td>
<td>ROX™ dye</td>
<td></td>
</tr>
</tbody>
</table>

**About the VeriFlex™ Technology**

The StepOnePlus instrument contains six independently thermally regulated VeriFlex™ blocks to help you optimize your thermal cycling conditions. You can set a different temperature for one or more of the VeriFlex blocks, creating up to six different zones for samples, or you can set the same temperature for each of the VeriFlex blocks.

**For More Information**

- For information on:
  - The StepOne and StepOnePlus systems, refer to *Applied Biosystems StepOne™ Real-Time PCR Software Help*.

  **Note:** To access the Help, select Help > StepOne Software Help from within the StepOne software.

  - Relative standard curve and/or comparative $C_T$ ($\Delta\Delta C_T$) experiments, refer to *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Standard Curve and Comparative $C_T$ Experiments*.
Supported Consumables

StepOne System

The StepOne system supports the consumables listed below. These consumables are for use with both standard and Fast reagents/protocols.

**IMPORTANT!** Use only Fast consumables (reaction plates, tube strips, and tubes) with the StepOne and StepOnePlus systems, even when performing an experiment with standard reagents.

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>• MicroAmp® Fast Optical 48-Well Reaction Plate</td>
<td>• 4375816</td>
</tr>
<tr>
<td>• MicroAmp® 48-Well Optical Adhesive Film</td>
<td>• 4375323 and 4375928</td>
</tr>
<tr>
<td>• MicroAmp® Fast 8-Tube Strip</td>
<td>• 4358293</td>
</tr>
<tr>
<td>• MicroAmp® Optical 8-Cap Strip</td>
<td>• 4323032</td>
</tr>
<tr>
<td>• MicroAmp® Fast Reaction Tube with Cap</td>
<td>• 4358297</td>
</tr>
<tr>
<td>• MicroAmp® Fast 48-Well Tray</td>
<td>• 4375282</td>
</tr>
<tr>
<td>• MicroAmp® 48-Well Base Adaptor</td>
<td>• 4375284</td>
</tr>
<tr>
<td>• MicroAmp® 96-Well Support Base</td>
<td>• 4379590</td>
</tr>
</tbody>
</table>

# Consumable

<table>
<thead>
<tr>
<th>#</th>
<th>Consumable</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>MicroAmp® Fast Optical 48-Well Reaction Plate</td>
</tr>
<tr>
<td>B</td>
<td>MicroAmp® Fast 48-Well Tray</td>
</tr>
<tr>
<td>C</td>
<td>MicroAmp® 96-Well Support Base</td>
</tr>
<tr>
<td>D</td>
<td>MicroAmp® Optical 8-Cap Strip</td>
</tr>
<tr>
<td>E</td>
<td>MicroAmp® Fast 8-Tube Strip</td>
</tr>
<tr>
<td>F</td>
<td>MicroAmp® Fast Reaction Tube with Cap</td>
</tr>
<tr>
<td>G</td>
<td>MicroAmp® 48-Well Optical Adhesive Film</td>
</tr>
<tr>
<td>H</td>
<td>MicroAmp® 48-Well Base Adaptor</td>
</tr>
</tbody>
</table>

Notes
The StepOnePlus system supports the consumables listed below. These consumables are for use with both standard and Fast reagents/protocols.

**IMPORTANT!** Use only Fast consumables (reaction plates, tube strips, and tubes) with the StepOne and StepOnePlus systems, even when performing an experiment with standard reagents.

<table>
<thead>
<tr>
<th>Consumable</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>• MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode</td>
<td>• 4346906 and 4366932</td>
</tr>
<tr>
<td>• MicroAmp® Optical Adhesive Film</td>
<td>• 4360954 and 4311971</td>
</tr>
<tr>
<td>• MicroAmp® Fast 8-Tube Strip</td>
<td>• 4358293</td>
</tr>
<tr>
<td>• MicroAmp® Optical 8-Cap Strip</td>
<td>• 4323032</td>
</tr>
<tr>
<td>• MicroAmp® Fast Reaction Tube with Cap</td>
<td>• 4358297</td>
</tr>
<tr>
<td>• MicroAmp® 96-Well Tray for VeriFlex™ Blocks</td>
<td>• 4379983</td>
</tr>
<tr>
<td>• MicroAmp® 96-Well Support Base</td>
<td>• 4379590</td>
</tr>
<tr>
<td>• MicroAmp® Adhesive Film Applicator</td>
<td>• 4333183</td>
</tr>
<tr>
<td>• MicroAmp® Cap Installing Tool (Handle)</td>
<td>• 4330015</td>
</tr>
</tbody>
</table>

---

**Notes**

---

About Genotyping Experiments

**Endpoint Experiments**

Genotyping experiments are endpoint experiments. In endpoint experiments:

- Data are collected at the end of the PCR process.
- Reactions are characterized by the quantity of target sequence accumulated at the end of the PCR (Saiki *et al.*, 1985).
- The datapoint is the normalized intensity of the reporter dye, or Rn.

**Note:** Some endpoint experiments also include pre-PCR datapoints. If so, the system calculates the delta Rn (ΔRn) value per the following formula:

\[ \Delta Rn = Rn \text{ (post-PCR read)} - Rn \text{ (pre-PCR read)} \]

where Rn = normalized reporter

**Note:** In this guide, the term *experiment* refers to the entire process of performing a run using the StepOne or StepOnePlus system, including setup, run and analysis.

---

**Real-Time PCR Data for Endpoint Experiments**

The StepOne software provides the option of collecting real-time data for both presence/absence and genotyping experiments. In the event that an experiment fails, the real-time data can help you determine the cause of the failure.

---

**About TaqMan® SNP Genotyping Assays**

A genotyping assay detects variants of a single nucleic acid sequence, without quantifying the target. The presence of two probes in each reaction allows genotyping of the two possible variants at the single nucleotide polymorphism (SNP) site in a target sequence.

Each TaqMan® SNP Genotyping Assay consists of a single, ready-to-use tube containing:

- Two sequence-specific primers for amplifying the polymorphism of interest
- Two allele-specific TaqMan® MGB probes for detecting the alleles for the specific polymorphism of interest

**About TaqMan® MGB Probes**

Each allele-specific TaqMan® MGB probe has:

- A reporter dye at its 5’ end
  - VIC® dye is linked to the 5’ end of the Allele 1 probe.
  - FAM™ dye is linked to the 5’ end of the Allele 2 probe.

The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the square brackets of the context sequence in the assay information file (AIF) shipped with each order. The Allele 2 FAM™ dye-labeled probe corresponds to the second nucleotide inside the square brackets of the context sequence in the AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe will bind to the G allele, and the FAM™ dye-labeled probe to the T allele.

- A minor groove binder (MGB), which increases the melting temperature (T_m) for a given probe length, allows the design of shorter probes (Alfonina *et al.*, 1997, Kutyavin *et al.*, 1997). The use of shorter probes results in greater differences in T_m values between matched and mismatched probes, and more robust genotyping.
- A nonfluorescent quencher (NFQ) at its 3’ end, allowing for detection of the reporter dye fluorescence with greater sensitivity than with a fluorescent quencher.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as a reporter or quencher with the StepOne system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus system.

### 5’ Nuclease Assay

The figure below is a schematic depiction of the 5´ nuclease assay. During PCR:

- Each TaqMan® MGB probe anneals specifically to its complementary sequence between the forward and reverse primer sites.
- When the oligonucleotide probe is intact, the proximity of the quencher dye to the reporter dye quenches the reporter signal.
- AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic DNA template.
- AmpliTaq Gold® DNA polymerase (with its 5´ nuclease activity) cleaves probes that are hybridized to the target sequence.
- Cleavage of the probes hybridized to the target sequence separates the quencher dye from the reporter dye, resulting in increased fluorescence by the reporter. The fluorescence signal generated by PCR amplification indicates which alleles are present in the sample.
Minimizing Non-Specific Fluorescence

In TaqMan® assays, fluorescence from nonspecifically bound probes is reduced, because nucleotide mismatches between a probe and a sequence reduce the chances that the probe will be cleaved. The probe’s short length means a one base pair mismatch will have a larger negative effect on the binding. The mismatched probe will not bind tightly to the allele, allowing the AmpliTaq® Gold DNA polymerase likely to displace the probe without cleaving the dye.

Reading and Analyzing the Plates

The StepOne software genotypes the DNA samples from the reaction plate simultaneously. First, the software normalizes the fluorescence of the reporter dyes to the fluorescence of the passive reference dye in each well. Next, the software plots the normalized intensities (Rn) of the reporter dyes in each sample well on an Allelic Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific probes. Finally, the StepOne software algorithmically clusters the sample data, and assigns a genotype call to the samples of each cluster according to its position on the plot.

Note: The StepOne software clustering algorithm does not call genotypes when only one genotype is present in an experiment.

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis (Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the extent of reporter dye fluorescent intensity after PCR amplification. The table below shows the correlation between fluorescence signals and sequences in a sample.

<table>
<thead>
<tr>
<th>A substantial increase in…</th>
<th>Indicates…</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIC® dye-labeled probe fluorescence only</td>
<td>Homozygosity for Allele 1</td>
</tr>
<tr>
<td>FAM™ dye-labeled probe fluorescence only</td>
<td>Homozygosity for Allele 2</td>
</tr>
<tr>
<td>Both VIC® and FAM™ dye-labeled probes fluorescence</td>
<td>Allele 1-Allele 2 heterozygosity</td>
</tr>
</tbody>
</table>

Notes
Supported Reagents
The StepOne and StepOnePlus systems support the following reagents for genotyping experiments:

- TaqMan reagents
- Other fluorescence-based reagents

If you use other fluorescence-based reagents on the StepOne and StepOnePlus systems, note the following:

- You must design your experiment using Advanced Setup instead of the Design Wizard. (See “Advanced Setup Workflow” on page 100.)
- For Applied Biosystems TaqMan reagents, the StepOne software automatically calculates reaction volumes in the Reaction Setup screen.

How to Use This Guide
This guide functions as both a tutorial and as a guide for performing your own experiments.

Using This Guide as a Tutorial
By using the example experiment data provided with the StepOne software, you can use this guide as a tutorial for performing a standard curve experiment on a StepOne or StepOnePlus system. Follow the procedures in Chapters 2 to 5:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Design the experiment using the Design Wizard in the StepOne software.</td>
</tr>
<tr>
<td>3</td>
<td>Prepare the experiment, using the reagents and volumes calculated by the Design Wizard in Chapter 2.</td>
</tr>
<tr>
<td>4</td>
<td>Run the experiment on a StepOne or StepOnePlus instrument (standalone or colocated layout)</td>
</tr>
<tr>
<td>5</td>
<td>Analyze the results.</td>
</tr>
</tbody>
</table>

For more information, see “About the Example Experiment” on page 10.

Using This Guide with Your Own Experiments
After completing the tutorial exercises in Chapters 2 to 5, you can use this guide to lead you through your own genotyping experiments. Each procedure in Chapters 2 to 5 includes a set of guidelines that you can use to perform your own experiments.
Additionally, you can use one of the other workflows provided in the StepOne software to perform your experiments. The table below provides a summary of all the workflows available in the StepOne software.

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Wizard</td>
<td>Set up a new experiment with guidance from the software. The Design Wizard walks you through best practices as you create your own experiment. The Design Wizard is recommended for new users. <strong>Note:</strong> Design options are more limited in the Design Wizard than in Advanced Setup.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Advanced Setup</td>
<td>Set up a new experiment using advanced options. Advanced Setup allows design flexibility as you create your own experiment. Advanced Setup is recommended for experienced users.</td>
<td>page 100</td>
</tr>
<tr>
<td>QuickStart</td>
<td>Run a new experiment with no plate setup information. If desired, you can add all design parameters after the run.</td>
<td>page 101</td>
</tr>
<tr>
<td>Template</td>
<td>Set up a new experiment using setup information from a template.</td>
<td>page 103</td>
</tr>
<tr>
<td>Export/Import</td>
<td>Import experiment designs from ASCII text files that contain experiment setup information.</td>
<td>page 105</td>
</tr>
</tbody>
</table>

**About the Example Experiment**

To illustrate how to perform genotyping experiments, this guide leads you through the process of designing and analyzing an example experiment. The example experiment represents a typical setup that you can use to quickly familiarize yourself with a StepOne or StepOnePlus system.

**Description**

The objective of the example genotyping experiment is to investigate SNP rs8039, where possible genotypes are AA, AC, and CC. In the example, 20 unknown genomic DNA (gDNA) samples were genotyped using TaqMan® Drug Metabolism Genotyping Assay ID C__11711420_30. The reactions were set up so that the PCR primers and probes that target both alleles of SNP rs8039 were present in the same well. The PCR was performed using the TaqMan® Universal PCR Master Mix and run according to the protocol that is described in the *Performing a TaqMan® Drug Metabolism Genotyping Assay for 96-Well Plates Quick Reference Card*. 
Chapter 1 Get Started
About the Example Experiment

Reaction Plate Layout

The genotyping example experiment was created for a StepOne instrument. For the StepOne instrument, the software displays a 48-well reaction plate layout:

You can create the example experiment for a StepOnePlus instrument; however, your reaction plate layout will differ from the 48-well reaction plate layout shown throughout this guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate layout:

About the Example Data

In this getting started guide you will use two files:

- In Chapter 2, you will create a genotyping example experiment file that contains setup data and save it to the experiments folder on your computer:
  \<drive>:\Applied Biosystems\<software name>\experiments\Genotyping Example.eds

- In Chapter 5, you will view results in a genotyping example experiment file that contains run data. The data file for the example experiment installs with the StepOne software. You can find the data file for the example experiment on your computer:
  \<drive>:\Applied Biosystems\<software name>\experiments\examples\Genotyping Example.eds

Notes
where:

- \(<drive>\) is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
- \(<software\ name>\) is the current version of the StepOne software.

### Data Files in the Examples Folder

The examples folder contains several data files that you can reference when analyzing your own data, as listed below. The data files install with the StepOne software.

**Note:** Be sure to use the Genotyping Example.eds file when performing the tutorial procedures in this guide. The 96-Well Genotyping Example.eds file is a different example of the genotyping method.

<table>
<thead>
<tr>
<th>StepOne Instrument</th>
<th>StepOnePlus Instrument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparative CT Example.eds</td>
<td>96-Well Comparative CT Example.eds</td>
</tr>
<tr>
<td>Comparative CT Study Bio Replicates Example.edm</td>
<td>——</td>
</tr>
<tr>
<td>Comparative CT Study Example.edm</td>
<td>——</td>
</tr>
<tr>
<td>Genotyping Example.eds</td>
<td>96-Well Genotyping Example.eds</td>
</tr>
<tr>
<td>Multiplex Example.eds</td>
<td>96-Well Multiplex Example.eds</td>
</tr>
<tr>
<td>Presence Absence Example.eds</td>
<td>96-Well Presence Absence Example.eds</td>
</tr>
<tr>
<td>Relative Standard Curve Example.eds</td>
<td>96-Well Relative Standard Curve Example.eds</td>
</tr>
<tr>
<td>RNase P Experiment.eds</td>
<td>96-Well RNase P Experiment.eds</td>
</tr>
<tr>
<td>Standard Curve Example.eds</td>
<td>96-Well Standard Curve Example.eds</td>
</tr>
<tr>
<td>SYBR Example.eds</td>
<td>96-Well SYBR Example.eds</td>
</tr>
</tbody>
</table>
Example Experiment Workflow

The following figure shows the workflow for the genotyping example experiment.

1. Create a new experiment.
2. Define the experiment properties.
3. Define the methods and materials.
4. Set Up the SNP assays.
5. Set Up the samples and replicates.
6. Set Up the run method.
7. Review the reaction setup.
8. Order materials for the experiment.

1. Prepare the sample dilutions.
2. Prepare the reaction mix.
3. Prepare the reaction plate.

1. Prepare for the run.
2. (Optional) Enable the notification settings.
3. Start the run.
4. Monitor the run.
5. Unload the instrument and transfer the data.

1. View the allelic discrimination plot.
2. View the plate layout.
3. View the results in a table.
4. View the quality summary.
5. View the raw data plot.
6. View the multicomponent plot.
7. View the amplification plot.
8. View the analysis settings.
9. Publish the data.
Chapter 2

Design the Experiment

This chapter covers:

- Chapter Overview .................................................. 16
- Create a New Experiment ........................................... 17
- Define the Experiment Properties ............................... 19
- Define the Methods and Materials ............................... 21
- Set Up the SNP Assays .............................................. 23
- Set Up the Samples and Replicates. .............................. 25
- Set Up the Run Method ............................................. 27
- Review the Reaction Setup ....................................... 29
- Order Materials for the Experiment ............................ 32
- Finish the Design Wizard .......................................... 35

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing F1, clicking in the toolbar, or selecting Help > StepOne Software Help.
Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne™ software to set up the genotyping example experiment. The Design Wizard walks you through Applied Biosystems recommended best practices as you enter design parameters for the example experiment.

Workflow

The workflow for designing the example experiment provided with this getting started guide is shown below.

Note: Design the example experiment using the Design Wizard in the StepOne software. When you design your own experiments, you can select alternate workflows (see “Using This Guide with Your Own Experiments” on page 9).
Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

1. Double-click (StepOne software) or select Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ <software name>

   where <software name> is the current version of the StepOne software.

2. In the Login dialog box, create a user name:
   a. In the User Name field, enter EXAMPLEUSER. You cannot enter spaces in the User Name field.
   b. Click OK.

3. From the Home screen, click (Design Wizard) to open the Design Wizard.
When you design your own experiment, you can do one of the following in the Login dialog box:

- Log in as a new user – In the User Name field, enter a user name, then click **OK**.

  **Note:** You cannot use the following characters in the User Name field: space, forward slash (/), backslash (\), greater than sign (>) and less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

- Log in as an existing user – From the User Name dropdown menu, select an existing user, then click **OK**.
- Log in anonymously – Click **Log in as Guest**.

Applied Biosystems recommends that you log in with a user name. If you log in with a user name, you can set preferences in the software. The next time you log in to the software with the same user name, the software uses the preferences you set as the defaults.

**IMPORTANT!** If you log in to the software as a Guest, you cannot set preferences.

You can set preferences as follows:

- **Save as the default checkboxes** – Select the **Save as the default** checkboxes as needed. The Save as the default checkboxes appear on the Home screen, on the Export Data dialog box, and on several Analysis screens.

- **Preferences dialog box** – Select **Tools > Preferences** to open the Preferences dialog box. In the Defaults and/or Startup tabs, change the preferences as desired.

For more information, access the StepOne Software Help by clicking **F1**.
Define the Experiment Properties

On the Experiment Properties screen, enter identifying information for the experiment, select the instrument type, then select the type of experiment to design.

1. Click the **Experiment Name** field, then enter **Genotyping Example**.

2. Leave the Barcode field empty.

   **Note:** The MicroAmp® Fast Optical 48-Well Reaction Plate does not have a barcode.

3. Click the **User Name** field, then enter **Example User**.

4. Click the **Comments** field, then enter **Genotyping Getting Started Guide**.

5. Select **StepOne™ Instrument (48 Wells)**.

   **Note:** The example experiment was created for a StepOne instrument. You can create the example experiment for a StepOnePlus instrument; however, your reaction plate layout will differ from the layout shown in this guide. The software displays a 48-well reaction plate layout for the StepOne instrument and a 96-well reaction plate layout for the StepOnePlus instrument. To create the example experiment for a StepOnePlus instrument, select **StepOnePlus™ Instrument (96 Wells)**.

6. Select **Genotyping** for the experiment type.

7. Click **Next >**.

---

**Notes**

---

**Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Genotyping Experiments**

19
**Design Guidelines**

When you design your own experiment:

- **Enter an experiment name:**
  - The experiment name is used as the default file name.
  - Enter a name that is descriptive and easy to remember. You can enter up to 100 characters in the Experiment Name field.

  **Note:** You cannot use the following characters in the Experiment Name field: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), semicolon (;), sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex (^), left parenthesis ( ( ), right parenthesis ( ) ), or exclamation point (!).

**IMPORTANT!** If you will run the instrument in standalone mode from the instrument touchscreen, you cannot enter more than 32 characters in the Experiment Name field and you cannot include spaces in the name.

- **(Optional) If you use a MicroAmp® Fast Optical 96-Well Reaction Plate, enter a barcode of up to 100 characters to identify the reaction plate that you use in the experiment.

  **Note:** The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

- **(Optional) Enter a user name to identify the owner of the experiment. You can enter up to 100 characters in the User Name field.**

- **(Optional) Enter comments to describe the experiment. You can enter up to 1000 characters in the Comments field.**

- **Select the instrument you are using to run the experiment:**
  - **StepOne™ Instrument (48 Wells)**
  - **StepOnePlus™ Instrument (96 Wells)**

  **Note:** You can use StepOne Software v2.1 or later to design experiments for both the StepOne and StepOnePlus instruments. The instrument you select in the Experiment Properties screen affects the reaction plate layout and materials list.

  **Note:** To set the default instrument type, select **Tools > Preferences**, then select the **General** tab (default). From the Default Instrument Type dropdown menu, select the appropriate instrument. To change the default instrument type, you must be logged into the software with a user name, not as a Guest. For more information, see the “Design Guidelines” for logging in on page 18.

- **Select Genotyping** as the experiment type.
Define the Methods and Materials

On the Methods and Materials screen, define the:

- Reagents that you are using to genotype samples
- State (wet or dry) of DNA template that you are genotyping
- Ramp speed best suited for the PCR reactions
- Stages to include in the method

About the Example Design

The example experiment uses TaqMan® reagents and wet genomic DNA (gDNA) template in the PCR reactions. Because the reactions do not contain TaqMan® Fast reagents, the StepOne or StepOnePlus system performs the run using the standard ramp speed. Also, because the instrument performs the thermal cycling for the PCR, the run method for the experiment consists of Pre-PCR Read, Amplification, and Post-PCR Read stages.

Complete the Screen

1. Select TaqMan® Reagents for the reagents.
2. Select Wet DNA (gDNA or cDNA) for the template type.
3. Select Standard (~2 hours to complete a run) for the ramp speed.
4. Select Pre-PCR Read and Amplification to add the stages to the run method.
   
   Note: The Post-PCR read is required.

5. Select Next >.
Design Guidelines

When you design your own experiment:

- Select Other if you are not using TaqMan® reagents to amplify and detect the target sequences in your experiment.

**Note:** The Reaction Setup screen is not available if you select Other.

- If you use a template other than genomic DNA (gDNA) or cDNA, select the option (Wet DNA or Dry DNA) that describes the state of your samples.
- Select the appropriate ramp speed for the instrument run:
  - Select Fast (~ 40 minutes to complete a run) if you use fast reagents for the PCR reactions.
  - Select Standard (~ 2 hours to complete a run) if you use standard reagents for the PCR reactions.
- If you are going to perform the PCR amplification on a thermal cycler other than a StepOne or StepOnePlus system, deselect the Amplification option.

**Note:** The pre-PCR read is optional, but recommended. The StepOne software uses the pre-PCR read to normalize the post-PCR data.

For More Information

For more information on:

- The Materials & Methods screen, access the StepOne Software Help by clicking or pressing F1.
- Advanced Setup, see “Advanced Setup Workflow” on page 100.
Set Up the SNP Assays

On the Set Up SNP Assays screen, enter the number of SNP assays in the experiment, then define the properties for each SNP assay.

The example experiment evaluates samples for SNP rs8039. Because the assay is a TaqMan® Drug Metabolism Genotyping Assay (Assay ID C__11711420_30), the SNP assay information can be imported from the Assay Information File (AIF) shipped with the assay, or downloaded from the Applied Biosystems website.

About the Example Design

Complete the SNP Assays Screen

1. For the number of SNP assays being studied, enter 1.
2. Click Yes (Select SNP Assay from Library).
3. Click Select SNP Assay(s) from Library.
4. Click Import AIF, then use the Import SNP Assays from AIF dialog box to import the SNP assay from the AIF:
   a. Navigate to:
      `<drive>:\Applied Biosystems\<software name>\experiments\examples`
   b. Select Text Files (*.txt) from the Files of type dropdown list.
   c. Select `DME_SNP_185457113_426781-1.txt`.
   d. Click Import.
5. In the Import SNP Assays dialog box, click OK.
6. Select the C__11711420_30 SNP assay.
7. Click Use Selected SNP Assay(s).
8. Select Next >.
Notes

Design Guidelines

When you design your own experiments:

- Applied Biosystems recommends that you evaluate no more than six SNPs on a reaction plate.

  Note: The Design Wizard allows no more than two SNPs per plate. Advanced Setup or Quickstart do not restrict the number of SNPs you can evaluate.

- Identify each SNP assay with a unique name and color.

- If you do not choose to set up your SNP assays manually, make certain that the reporter dyes you assign to each allele are correct.

  IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as a reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.
After saving your experiment, you can edit the SNP assays if needed:

- Open the saved experiment.
- From the Experiment Menu pane, select **Setup > Plate Setup**.

**Note:** If you edit an allele name, the new name appears in the Well Table and in published reports. In addition, the name you enter for Allele 1 corresponds to the x-axis in the plots; the name you enter for Allele 2 corresponds to the y-axis in the plots.

---

### For More Information

For more information on:
- The Targets SNP Assays screen, access the StepOne Software Help by clicking or pressing **F1**.
- Editing SNP assays in the Plate Setup screen, access the StepOne Software Help by clicking or pressing **F1**.

---

### Set Up the Samples and Replicates

On the Set Up Samples and Replicates screen, enter the number of samples in the experiment, enter sample names, then enter the number of negative and positive controls.

**About the Example Design**

The example experiment evaluates:

- 20 unknown samples
- 2 negative controls
- 2 positive controls (a heterozygote and an Allele 2 homozygote).

**Complete the Samples and Replicates Screen**

1. For the number of samples, enter **20**.
2. For the number of replicates, enter **1**.
3. Click **All Sample/SNP Assay Reactions**.
4. For the number of negative controls (wells that contain no template), enter **2**.
5. For the number of positive controls (wells that contain samples of known genotypes), enter **2**.
6. For Positive Control 1, select **Allele 1/Allele 2 Heterozygous**.
7. For Positive Control 2, select **Allele 2 Homozygous**.
8. Select **Next >**.
## Design Guidelines

When you design your own experiment:

- Use between:
  - 1 and 48 samples for the StepOne instrument
  - 1 and 96 samples for the StepOnePlus instrument
- Enter a unique name and color for each sample.
- Applied Biosystems recommends using at least one negative control for each SNP assay.
- Limit the number of total reactions in each experiment to 48 or less. If the number of total reactions required is greater than 48, reduce the number of SNP assays, samples, replicates, or positive and negative controls; or divide the reactions between two or more reaction plates.
- If you are running the experiment on a StepOnePlus instrument and plan to edit the Run Method (page 27) to set a different temperature for one or more of the VeriFlex blocks, you need to:
  b. In the Plate Setup screen, select the View Plate Layout tab, then select the Enable VeriFlex™ Block checkbox.

**IMPORTANT!** If you do not select the Enable VeriFlex™ Block checkbox in the Plate Setup screen, you will not be able to set a different temperature for one or more of the VeriFlex blocks in the Run Method screen (page 27).

### For More Information
For more information on the Samples & Replicates screen, access the StepOne Software Help by clicking or pressing F1.
Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the default run method. If needed, you can edit the default run method or replace it with one from the Run Method library.

The example experiment runs 25-µL reactions using the TaqMan® Drug Metabolism Genotyping Assay method shown below. Because the StepOne system is used to perform the thermal cycling, the run method contains a Cycling stage for the PCR.

### About the Example Design

1. **Stage/Step**
   - **Pre-PCR Read**
     - Holding Stage
   - **Thermal Cycling**
     - Denature
     - Anneal/Extend
     - Cycling (50 cycles)
     - Holding Stage
   - **Post-PCR Read**
     - Holding Stage
2. **Temperature**
   - 60 °C
   - 95 °C
   - 92 °C
   - 60 °C
   - 60 °C
3. **Time (mm:ss)**
   - 00:30
   - 10:00
   - 00:15
   - 01:00
   - 00:30
4. **Data Collection**
   - Yes
   - No
   - No
   - Yes
   - Yes

**Note:** In the method above, data collection is activated for the Anneal/Extend step so that the instrument collects real-time data during the PCR. Although the real-time data are not necessary for genotyping, the data can be useful when troubleshooting failed PCR.

1. **Review the Run Method Screen**
   1. Click the **Reaction Volume Per Well** field, then enter **25**.
   2. Click the **Number of Cycles** field of the Cycling Stage, then enter **50**.
   3. Adjust the first step of the Cycling Stage: Click the temperature setting (95 °C), then enter **92 °C**.
   4. Adjust the second step of the Cycling Stage: Click the time setting (01:00), then enter **01:30**.
   5. Click **Next >**.
When you design your own experiment:

- Enter a reaction volume/well of 10 to 30 µL. Applied Biosystems recommends a reaction volume of 25 µL for genotyping experiments.
- Review the default run method. If your experiment requires different settings, edit the default method as needed.
- Click **Open Run Method** to view a library of run methods. The library may contain the run method for your experiment.
- Consider including amplification in the run method. Real-time data can be useful when troubleshooting a genotyping experiment.
- If you are running the experiment on a StepOnePlus instrument and you want to set a different temperature for one or more of the VeriFlex blocks, you need to:
  b. In the Plate Setup screen (page 26), select the **View Plate Layout** tab, then select the **Enable VeriFlex™ Block** checkbox.

  **IMPORTANT!** If you do not select the **Enable VeriFlex™ Block** checkbox in the Plate Setup screen, you will not be able to set a different temperature for one or more of the VeriFlex blocks in the Run Method screen.
  
  c. In the Run Method screen, select the Graphical View tab.
Chapter 2 Design the Experiment

Review the Reaction Setup

For each VeriFlex™ block you want to change, click the temperature, then enter the desired value.

**Note:** You can set a different temperature for one or more of the VeriFlex blocks, or set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex blocks are not set to the same temperature, the temperature difference must be between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

**For More Information**

For more information on:
- The Run Method Library or on completing the Run Method screen, access the StepOne Software Help by clicking or pressing F1.
- Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by clicking or pressing F1.
- Using Advanced Setup, see “Advanced Setup Workflow” on page 100.

Review the Reaction Setup

On the Set Up Reaction Setup screen, enter the reaction volume and the number of excess reactions to prepare, then review the concentration settings for the PCR master mix, assay mix, diluted sample target, and sample stock(s), and make changes as necessary.

**About the Example Design**

The example experiment requires sufficient reaction mix for 24 reactions and a 10 percent volume for pipetting error. Each 25-µL reaction consists of the following:

<table>
<thead>
<tr>
<th>Component</th>
<th>µL/Well</th>
</tr>
</thead>
<tbody>
<tr>
<td>2X TaqMan® Universal PCR Master Mix, No AmpErase® UNG</td>
<td>12.50</td>
</tr>
<tr>
<td>20X TaqMan® Drug Metabolism Genotyping Assay</td>
<td>1.25</td>
</tr>
<tr>
<td>Genomic DNA template (3 to 20 ng) + DNAse-free water</td>
<td>11.25</td>
</tr>
<tr>
<td><strong>Total volume</strong></td>
<td>25.00</td>
</tr>
</tbody>
</table>

**Complete the Reaction Setup Screen**

1. Click the **Reaction Volume Per Well** field, then enter 25 µL.
2. Click the **Excess Reaction Volume** field, enter 10%.
3. Confirm that the master mix concentration is 2.0X.
4. Confirm that the assay mix concentration is 20.0X.
5. Select the Sample Dilution Calculations tab.

6. Click the Diluted Sample Concentration (10× for Reaction Mix) field, then enter 30 ng/µL.

7. Confirm that the stock concentration of all samples are 100ng/µL.

8. Print a report of the plate layout for reference:
   a. Click Print Reaction Setup.
   b. In the dialog box, select:
      • Detailed Reaction Setup Instructions
      • Include Plate Layout
      • Use sample color
   c. Click Print to send the reaction setup instructions to your printer.

9. Click Next >.
Design Guidelines

When you design your own experiment:

- Enter a reaction volume/well of 10 to 30 µL. Applied Biosystems recommends a reaction volume of 25 µL for genotyping experiments.
- Enter an excess reaction volume of at least 10 percent to allow for pipetting inaccuracies and other experimental error.
- If you use dry DNA template, the components and volumes are recalculated.

For More Information

For more information on the Reaction Setup screen, access the StepOne Software Help by clicking 📡 or pressing FI.
Order Materials for the Experiment

On the Materials List screen, review the list of materials recommended to prepare the PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order the recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection. Product availability and pricing may vary according to your region or country. Online ordering through the Applied Biosystems Store is not available in all countries. Contact your local Applied Biosystems representative for help.

Note: The StepOne software recommends the materials to order based on your experiment design. It is assumed that you will design your experiment, order your materials, then prepare (Chapter 3) and run (Chapter 4) the reaction plate when your materials arrive.

Complete the Ordering Materials Screen

1. In the Enter Gene Name or RS Number field, enter rs8039, then click Find Assay to get the assay from the Applied Biosystems website:
   a. In the Find Assay Results dialog box, select the C__11711420_30 assay.
   b. Click Apply Assay Selection.

2. From the Display dropdown menu, select All Items (default), then review the recommended materials. If needed, use the scroll bar at right to see all items.
   
   Note: For more information on a specific item, click the part number link. You will be connected to the product information page on Applied Biosystems Store. To access the Applied Biosystems Store, you need to have an Internet connection.

3. (Optional) Click Print Materials List to send the materials list to your printer.
4. (Optional) Create a shopping list:
   a. Select the checkbox next to each of the following items:
      - MicroAmp® Fast Optical 48-Well Reaction Plates
      - MicroAmp® 48-Well Optical Adhesive Film
      - MicroAmp® 96-Well Support Base
      - TaqMan® Universal PCR Master Mix, No AmpErase® UNG
      - C__11711420_30
   
   **Note:** The example experiment was created for a StepOne instrument. If you selected the StepOnePlus instrument in the Experiment Properties screen (page 19), the 96-well consumables (for example, the MicroAmp® Fast Optical 96-Well Reaction Plate) are listed in place of the 48-well consumables.

   b. Click **Add Selected Items to Shopping List**.

5. (Optional) Create a shopping basket on the Applied Biosystems Store:
   
   **Note:** To access the Applied Biosystems Store, you need to have an Internet connection. Product availability and pricing may vary according to your region or country. Online ordering through the Applied Biosystems Store is not available in all countries. Contact your local Applied Biosystems representative for help.

   a. Check that the Experiment Shopping List contains the desired materials and that the quantities are correct, then click **Order Materials in List**.

   b. In the Order Materials - Log In dialog box, enter your user name and password for the Applied Biosystems Store, then click **Login and Submit**.

   **Note:** If you do not have an account with the Applied Biosystems Store, click **Register Now** to create an account.

   c. When you are connected to the Applied Biosystems Store, follow the prompts to complete your order.

6. Go to “Finish the Design Wizard” on page 35.
Design the Experiment

Order Materials for the Experiment

Design Guidelines

When you design your own experiment:

- Select all the materials that you require for your experiment and add them to your shopping list.

**IMPORTANT!** Use only Fast consumables (reaction plates, tube strips, and tubes) with the StepOne and StepOnePlus systems, even when performing an experiment with standard reagents.

- To access the Applied Biosystems Store:
  - Confirm that your computer has an Internet connection.
  - Applied Biosystems recommends the following browsers and Adobe® Acrobat® Reader versions to use the Applied Biosystems web site:

<table>
<thead>
<tr>
<th>Desktop Operating System</th>
<th>Microsoft® Internet Explorer</th>
<th>Adobe® Acrobat® Reader</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® XP (Service Pack 2 or Service Pack 3)</td>
<td>v6.x</td>
<td>v4.0 or later</td>
</tr>
<tr>
<td>Windows® Vista</td>
<td>v7.x or later</td>
<td>v4.0 or later</td>
</tr>
</tbody>
</table>

**IMPORTANT!** Make sure that cookies and Java Script are turned on for the web site to function correctly.

For More Information

For more information on the Materials List screen, access the StepOne Software Help by clicking on  or pressing F1.
**Finish the Design Wizard**

On the Review Plate Layout for Experiment dialog box, select an option to finish the Design Wizard setup, review the plate layout and start the run.

1. At the bottom of the StepOne software screen, click **Finish Designing Experiment**.
2. Review the plate layout. If the plate layout is incorrect, select **Return to the Wizard** and check your entered values.
3. Click **Save Experiment**.
4. In the Save Experiment dialog box, click **Save** to accept the default file name and location. The example experiment is saved and closed, and you are returned to the Home screen.

**Note:** By default, the example experiment is saved to the `<drive>:\Applied Biosystems\<software name>\experiments` folder.
Design Guidelines

When you design your own experiment:

- In the Review Plate for Experiment window, select the appropriate exit option:

<table>
<thead>
<tr>
<th>Click</th>
<th>if you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Experiment</td>
<td>Save and close the experiment without making any further changes or starting the run.</td>
</tr>
<tr>
<td>Start Run for This Experiment</td>
<td>Save the experiment and start the run. Make sure the reaction plate is loaded in the instrument.</td>
</tr>
<tr>
<td>Edit Plate Layout</td>
<td>• Use advanced setup to edit the plate layout.</td>
</tr>
<tr>
<td></td>
<td>• (StepOnePlus instrument only) Set a different temperature for one or more of the VeriFlex blocks using Advanced Setup.</td>
</tr>
<tr>
<td>Create Another Experiment Using the Design Wizard</td>
<td>Save and close the current experiment, then create another experiment using the Design Wizard.</td>
</tr>
<tr>
<td>Return to the Wizard</td>
<td>Return to the experiment to make changes using the Design Wizard.</td>
</tr>
</tbody>
</table>

- By default, experiments are saved to the `<drive>\Applied Biosystems\<software name>\experiments` folder. To change the:
  - Save location for a specific experiment, navigate to the desired location using the Save Experiment dialog box.
  - Default save location, select Tools > Preferences, then select the General tab (default). In the Default Data Folder field, browse to the desired location.

**Note:** To change the default save location, you must be logged in to the software with a user name, not as a Guest. For more information, see the “Design Guidelines” for logging in on page 18.

For More Information

For more information on using Advanced Setup, see “Advanced Setup Workflow” on page 100.
Chapter 3

Prepare the Reactions

This chapter covers:

- Chapter Overview ......................................................... 38
- Prepare the Sample Dilutions ........................................... 39
- Prepare the Reaction Mix ................................................ 40
- Prepare the Reaction Plate .............................................. 42

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing F1, clicking 🌐 in the toolbar, or selecting Help ➔ StepOne Software Help.
Chapter Overview

This chapter explains how to prepare the PCR reactions for the genotyping example experiment and provides guidelines for how to prepare the PCR reactions for your own genotyping experiments.

Workflow

The workflow for preparing the PCR reactions for the example experiment provided with this getting started guide is shown below:

Start Experiment

Design the Experiment (Chapter 2)

Prepare the Reactions (Chapter 3)

1. Prepare the sample dilutions.
2. Prepare the reaction mix.
3. Prepare the reaction plate.

Run the Experiment (Chapter 4)

Analyze the Experiment (Chapter 5)

End Experiment

For More Information

For more information on preparing TaqMan® SNP Genotyping Assays, see:

- Custom TaqMan® SNP Genotyping Assays Protocol
- Custom TaqMan® Genomic Assays Protocol
- TaqMan® SNP Genotyping Assays Protocol
- TaqMan® Drug Metabolism Genotyping Assays Protocol
- Performing a Custom TaqMan® SNP Genotyping Assay for 96-Well Plates Quick Reference Card
- Performing a TaqMan® Drug Metabolism Genotyping Assay for 96-Well Plates Quick Reference Card
- Pre-Developed TaqMan® Assay Reagents Allelic Discrimination Protocol
- Allelic Discrimination Pre-Developed TaqMan® Assay Reagents Quick Reference Card

Note: The procedures in this chapter focus on the use of wet DNA samples. If you are using dried DNA, consult the chemistry protocol accompanying your PCR kit for details on reconstituting and plating your samples for use.
Prepare the Sample Dilutions

Dilute the sample stock to working concentrations using the volumes calculated by the StepOne software (see “Review the Reaction Setup” on page 29).

About the Example Experiment

The calculated volumes for the genotyping example experiment are listed below. The final concentration is 30.0 ng/µL.

<table>
<thead>
<tr>
<th>Tube</th>
<th>Sample Name</th>
<th>Sample Stock Concentration (ng/µL)</th>
<th>Volume (µL)</th>
<th>Sample Stock (µL)</th>
<th>DNAse-free Water (µL)</th>
<th>Diluted Sample Total (µL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sample 1</td>
<td>100.0</td>
<td>2.20</td>
<td>0.66</td>
<td>1.54</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sample 2</td>
<td>100.0</td>
<td>2.20</td>
<td>0.66</td>
<td>1.54</td>
<td></td>
</tr>
<tr>
<td>…</td>
<td>…</td>
<td>…</td>
<td>…</td>
<td>…</td>
<td>…</td>
<td>…</td>
</tr>
<tr>
<td>21</td>
<td>Sample 21</td>
<td>100.0</td>
<td>2.20</td>
<td>0.66</td>
<td>1.54</td>
<td></td>
</tr>
</tbody>
</table>

Required Materials

- DNAse-free water to dilute the sample
- Microcentrifuge tubes
- Pipettors and pipette tips
- Sample stock
- Vortexer
- Centrifuge

Prepare the Samples

1. Label a separate microcentrifuge tube for each sample: Sample 1, Sample 2,… through Sample 20.
2. Add 1.54 µL DNAse-free water to each empty tube.
3. Add 0.66 µL of the appropriate sample stock to each tube.
4. Vortex each diluted sample for 3 to 5 sec, then briefly centrifuge the tube(s).

Preparation Guidelines

When you prepare the samples for your own experiment:

- Use DNAse-free water to dilute the samples.
- Use the same quantity of DNA per well for each experiment.
- Do not heat the DNA samples.

For More Information

For more information on preparing TaqMan® SNP Genotyping Assays, refer to the protocol appropriate for the reagents you are using in the PCR reactions (see “For More Information” on page 38).

Notes
Prepare the Reaction Mix

Prepare the reaction mix for the experiment using the volumes calculated by the StepOne software. The StepOne software determines which reaction mix components to use based on the selections made in the Methods and Materials screen (see “Review the Reaction Setup” on page 29). For genotyping experiments, the reaction mix contains all components except sample, buffer, or positive control.

Required Materials

- TaqMan® Universal PCR Master Mix, No AmpErase® UNG (2X)
- TaqMan® Drug Metabolism Genotyping Assay (20X)
- DNAse-free water
- Microcentrifuge tubes
- Pipettors
- Pipette tips
- Centrifuge

**CAUTION** CHEMICAL HAZARD. TaqMan® 2X Universal PCR Master Mix, No AmpErase UNG may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

1. For the SNP assay, add the required volumes of each component to an appropriately sized tube:

<table>
<thead>
<tr>
<th>Component</th>
<th>Reaction Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Per Well(μL)</td>
</tr>
<tr>
<td></td>
<td>Dry</td>
</tr>
<tr>
<td>TaqMan® Universal PCR Master Mix (2X)</td>
<td>12.50</td>
</tr>
<tr>
<td>SNP Assay Mix (20X)</td>
<td>1.25</td>
</tr>
<tr>
<td>H₂O, DNase-free</td>
<td>11.25</td>
</tr>
<tr>
<td><strong>Total Reaction Mix Volume</strong></td>
<td><strong>25.00</strong></td>
</tr>
</tbody>
</table>

2. Gently pipette the reaction mix up and down, then cap the tube.

3. Centrifuge the tube briefly.
Preparation Guidelines

When you prepare the reaction mix for your own experiment, make sure you:

- Prepare the reactions for each SNP separately.
- Include excess volume in your calculations to provide excess volume for the loss that occurs during reagent transfers.
- Include all required components.
- Prepare the reagents according to the manufacturer’s instructions.
- Keep the assay mix protected from light in the freezer, until you are ready to use it. Excessive exposure to light may affect the fluorescent probes.

Prior to use:

- Mix the master mix thoroughly by swirling the bottle.
- Resuspend the assay mix by vortexing, then centrifuge the tube briefly.
- Thaw any frozen samples by placing them on ice. When thawed, resuspend the samples by vortexing, then centrifuge the tubes briefly.

For More Information

For more information on how to prepare the reaction mix, refer to the protocol appropriate for the reagents you are using in the PCR reactions (see “For More Information” on page 38).
Prepare the Reaction Plate

Load the reaction plate with the reaction mix from page 40 and the dilute samples from page 39. The reactions are added to wells according to the plate layout generated in the StepOne software (see “Set Up the Samples and Replicates” on page 25).

**Required Materials**

- Centrifuge
- MicroAmp® Fast Optical 48-Well Reaction Plate
- MicroAmp® Optical 48-Well Adhesive Film
- Pipettors and pipette tips

**Note:** The StepOne and StepOnePlus systems run only MicroAmp® Fast consumables.

**Prepare the Reaction Plate: Dried gDNA**

1. Pipette 2.5 µL of the appropriate sample (3 to 20 ng of purified genomic DNA) into each well of a 48-well optical reaction plate.
   
   All wells belonging to the same genotyping assay must contain the same quantity of sample or control.

2. Dry down the samples by evaporation at room temperature in a dark, amplicon-free location. (Cover the reaction plate with a lint-free tissue while drying.)

3. Transfer 25 µL of reaction mix to each well.

   **IMPORTANT!** Make sure that no cross-contamination occurs from well to well.

4. Seal the reaction plate with adhesive film.

5. Vortex the reaction plate for 3 to 5 sec.

6. Briefly centrifuge the reaction plate.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the plate again at a higher speed and for a longer period of time.

   **IMPORTANT!** Do not allow the bottom of the reaction plate to become dirty. Fluids and other contaminants that adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Correct" /></td>
<td><img src="image2.png" alt="Incorrect" /></td>
</tr>
</tbody>
</table>

**Notes**
Chapter 3 Prepare the Reactions
Prepare the Reaction Plate

**Prepare the Reaction Plate: Wet gDNA**

1. Dilute 2.5 μL of sample with 8.75 μL of DNase-free water. The volume of DNA sample and DNase-free water per reaction should be 11.25 μL.

2. Into each well of the reaction plate, pipette one control or sample aliquot of the volume (indicated in step 1) appropriate for the reaction plate type:
   a. For each unknown reaction, add 11.25 μL of the sample to the appropriate wells.
   b. For each negative control reaction, add 11.25 μL of DNAse-free water to the appropriate wells.
   c. For each positive control reaction, add 11.25 μL of the positive control to the appropriate wells.

**IMPORTANT!** Make sure the genotype for the positive control template that you add matches the genotype assigned to the well.

3. Transfer 13.75 μL of reaction mix to the appropriate wells.
4. Seal the reaction plate with optical adhesive film.
5. Vortex the reaction plate for 3 to 5 sec, then briefly centrifuge it.
6. Centrifuge the reaction plate briefly.

**IMPORTANT!** Do not allow the bottom of the reaction plate to become dirty. Fluids and other contaminants that adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an abnormally high background signal.

---

**Preparation Guidelines**

When you prepare the reaction plate for your own experiment:
- Make sure you use the appropriate consumables.
- Make sure the reaction locations match the plate layout in the StepOne software.
- If you are running less than 40 reactions, use tube strips rather than a reaction plate.
- Load 3 to 20 ng of purified genomic DNA per reaction
- All wells belonging to the same genotyping assay must contain the same quantity of sample or control.
- Multiple assays may be run on one reaction plate, but must be analyzed separately.

---

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid is at the bottom of the well.</td>
<td>• Not centrifuged with enough force, or</td>
</tr>
<tr>
<td></td>
<td>• Not centrifuged for enough time</td>
</tr>
</tbody>
</table>
If you use optical adhesive film to seal your reaction plates, seal each reaction plate as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the 96-well base.</td>
<td></td>
</tr>
<tr>
<td>2. Load the reaction plate as desired.</td>
<td></td>
</tr>
</tbody>
</table>
| 3. Remove a single optical adhesive film (film) from the box.           | ![Image](image1.png)  
| • For the StepOne system reaction plate, bend both end-tabs upward. Hold the film backing side up. | ![Image](image2.png)  
| • For the StepOnePlus system reaction plate, fold back one of the end-tabs. Hold the film backing side up. | ![Image](image3.png)  |
| 4. In one swift movement, peel back the white protective backing from the center sealing surface. Do not touch the center sealing surface. | ![Image](image4.png)  
| IMPORTANT! Improper peeling of the optical adhesive film may result in haziness, but will not affect results. Haziness will disappear when the film comes into contact with the heated cover in the instrument. | ![Image](image5.png)  |
| 5. Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive side facing the reaction plate). Be sure the film is completely covering all wells of the reaction plate. | ![Image](image6.png)  
| 6. While applying firm pressure, move the applicator slowly across the film, horizontally and vertically, to ensure good contact between the film and the entire surface of the reaction plate. | ![Image](image7.png)  
| 7. While using the applicator to hold the edge of the film in place, grasp one end of the end-tab and pull up and away sharply. Repeat for the other end-tab. | ![Image](image8.png)  
| 8. To ensure a tight, evaporation-free seal:                           |         |
| a. Repeat step 6.                                                     |         |
| b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film. |         |

**Note:** Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight, evaporation-free seal.
9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film.

For More Information  For more information on how to prepare the reaction plate, refer to the protocol appropriate for the reagents you are using in the PCR reactions (see “For More Information” on page 38).
This chapter covers:

■ Chapter Overview .......................................................... 48
■ Prepare for the Run ......................................................... 49
■ (Optional) Enable the Notification Settings ...................... 51
■ Start the Run ................................................................. 54
■ Monitor the Run .............................................................. 58
■ Unload the Instrument and Transfer the Data .................. 65

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing F1, clicking 📚 in the toolbar, or selecting Help ➤ StepOne Software Help.
Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems.

Example Experiment Workflow

The workflow for running the example experiment provided with this getting started guide is shown below.

Start Experiment

Design the Experiment (Chapter 2)

Prepare the Experiment (Chapter 3)

Run the Experiment (Chapter 4)
1. Prepare for the run.
2. (Optional) Enable the notification settings.
3. Start the run.
4. Monitor the run.
5. Unload the instrument and transfer the data.

Analyze the Experiment (Chapter 5)

End Experiment
Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2, then loading the sealed reaction plate into the StepOne™ or StepOnePlus™ instrument.

1. Double-click (StepOne software) or select Start ➤ All Programs ➤ Applied Biosystems ➤ StepOne Software ➤ <software name>
   where <software name> is the current version of the StepOne software.

2. In the Login dialog box, select EXAMPLEUSER from the User Name dropdown menu, then click OK.
   
   **Note:** EXAMPLEUSER is the user name you created when designing the genotyping experiment (page 17).

3. From the Home screen, click **Open**.

4. In the Open dialog box, navigate to the experiments folder (default):
   <drive>:\Applied Biosystems\<software name>\experiments

5. Double-click **Genotyping Example** to open the example experiment file you created in Chapter 2.
Load the Reaction Plate Into the Instrument

Physical Injury Hazard. During instrument operation, the temperature of the sample block(s) can exceed 100 °C. If the instrument has been used recently, keep your hands away until the sample block(s) reach room temperature.

Important! Wear powder-free gloves when you handle the reaction plate.

1. Open the instrument drawer.

2. Place the reactions in the sample block(s):
   - If using a reaction plate: Place the reaction plate in the sample block(s) with well A1 at the back-left corner.
   - If using reaction tube strips: Place the tray containing the tube strips in the sample block(s).
   - If using reaction tubes: Place the tray containing the tubes in the sample block(s).
Chapter 4 Run the Experiment
(Optional) Enable the Notification Settings

**IMPORTANT!** For optimal performance with partial loads:

**StepOnePlus instruments** – Load at least 16 tubes and arrange them in:

- Adjacent columns of 8 tubes, using rows A through H. For example, fill wells in column 1 (rows A through H) and column 2 (rows A through H).
  
  *or*

- Adjacent rows of 8 tubes, using columns 3 through 10. For example, fill wells in row A (columns 3 through 10) and row B (columns 3 through 10).

**StepOne instruments** – Load at least 4 tubes in the sample block.

3. Close the instrument drawer carefully.

---

**Important!** The notification settings feature is available only if the computer that you are using is running the StepOne or StepOnePlus instrument and is connected to an Ethernet network.

**Note:** The notification system is also available to computers that are monitoring a StepOne or StepOnePlus instrument remotely. For more information, see “Remote Monitor” on page 62.

---

**About the Example Experiment**

In the example experiment:

- The StepOne software is set up to send notifications to three users (scientist, supervisor, and technician at mycompany.com) when the StepOne or StepOnePlus system ends the run and if it encounters any errors during operation.

- The example SMTP server (www.mycompany.com) is set up for Secure Sockets Layer (SSL) encryption and requires authentication for use.
Set Up the Notification Settings

1. In the StepOne software, click **Run** in the navigation pane.
2. Click **Notification Settings**.
3. Select **Yes** for Enable Notifications.
4. Select the events that generate notifications:
   a. Select **Instrument Error**.
   b. Select **Run Completed**.
5. In the Enter e-mail addresses for notifications field, enter:
   scientist@mycompany.com, supervisor@mycompany.com, technician@mycompany.com.
6. In the Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.
7. Select **No** next to “Attach completed runs to message.”

   **Note:** This option applies only to e-mail notifications that are generated when the instrument completes a run (that is, **Run Completed** is selected in step 4).

8. Set the authentication settings:
   a. Select **Yes** for Server requires authentication.
   b. In the User Name field, enter **Example User**.
   c. In the Password field, enter **password**.

---

**Notes**
Run Guidelines

When you set up the StepOne or StepOnePlus system for automatic notification:

- Your system must be set up for network use. Refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide*.
- Select the events for which you want to receive e-mail notifications:
  - **Instrument Error** – When selected, recipients are e-mailed all errors encountered by the instrument during each run.
  - **Run Started** – When selected, recipients are e-mailed every time the instrument starts a run.
  - **Run Completed** – When selected, recipients are e-mailed every time the instrument completes a run.
- Obtain e-mail addresses to receive notifications.

**IMPORTANT!** Separate addresses with a comma (,).

- Contact your systems administrator or information technology department if you need:
  - E-mail addresses for users who will receive notifications
  - A network address for a simple mail transfer protocol (SMTP) server on the LAN
  - A user name and password for the server, if required for access
  - The Secure Sockets Layer (SSL) setting of the server (on or off)

- Click **Test Configuration** to test your notification settings. If the notification settings are set up correctly, sample e-mails are sent to the addresses you entered.
Start the Run

Start the run according to the layout of your StepOne or StepOnePlus system:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>The yellow cable connects the computer to the instrument</td>
<td>“Colocated Startup” below</td>
</tr>
<tr>
<td>Standalone</td>
<td>• The computer and the instrument are not connected, or</td>
<td>“Standalone Startup” on page 55</td>
</tr>
<tr>
<td></td>
<td>• The computer and the instrument are connected to the same network.</td>
<td></td>
</tr>
</tbody>
</table>

Colocated Startup

Perform this procedure if your computer is directly connected to your StepOne or StepOnePlus instrument by the yellow cable.

1. In the StepOne software, click Run in the navigation pane.

2. Click START RUN.
Perform these procedures if your computer and StepOne or StepOnePlus instrument are not directly connected by the yellow cable. Start with:

- “Send the Experiment to the Instrument Over the Network” on page 55 if your computer and instrument are connected to the same network.

  or

- “Transfer the Experiment to the Instrument Using a USB Drive” on page 55 if your computer and instrument are not connected to the same network.

### Send the Experiment to the Instrument Over the Network

1. In the StepOne software, click **Send Experiment to Instrument**.

2. In the Send Experiment to Instrument dialog box:
   a. Click **Browse**, navigate to the example experiment file, then click **Open**.
   b. Select the instrument to receive the experiment file.

   **Note:** If your instrument is not listed, set up the instrument for monitoring as explained in the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide*.

   c. Click **Send Experiment** to send the experiment to your instrument over the network.

3. When prompted, click **OK** to close the confirmation.

4. Go to “Start the Instrument Run Using the Touchscreen” on page 56.

### Transfer the Experiment to the Instrument Using a USB Drive

1. Connect the USB drive to one of the USB ports on the computer.

2. In the StepOne software, select **Save** ▶ **Save As**.

3. In the Save dialog box, navigate to the USB drive, then click **Save**.
4. Remove the USB drive from your computer, then connect it to the USB port of your StepOne or StepOnePlus instrument.

5. Go to “Start the Instrument Run Using the Touchscreen” below.

Start the Instrument Run Using the Touchscreen

1. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

   **Note:** If the touchscreen is not at the Main Menu screen, touch .

2. Wait for the USB sign to appear on the touchscreen.

3. In the Main Menu screen, touch **Browse/New Experiments**.

4. In the Browse screen, touch **Folders**.

5. In the Choose an Experiment Folder screen:

   - Touch **USB** if you transferred the experiment on a USB drive.
   - Touch **Default** if you sent the experiment over a network connection.

6. Before starting the run, save the example experiment to your instrument:

   a. In the Browse screen, touch the example experiment name, then touch **Copy**.
   b. In the Save Experiment screen, navigate to a destination folder, then click **Save & Exit**.

7. In the Browse screen, touch the example experiment name, then touch **Start Run**.
8. In the Run Parameters screen:
   a. Touch the **Reaction Volume** field, use the keypad to enter the reaction volume for the example experiment, then touch **Done**.
   b. Touch **Start Run Now**.

---

Notes
Monitor the Run

Monitor the run according to the layout of your StepOne or StepOnePlus system:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>The yellow cable connects the computer to the instrument.</td>
<td>“Colocated Monitoring” below</td>
</tr>
<tr>
<td>Standalone (Networked)</td>
<td>The computer and the instrument are connected to the same network.</td>
<td>“Remote Monitor” on page 62</td>
</tr>
<tr>
<td>Standalone (Basic)</td>
<td>The computer and the instrument are not connected.</td>
<td>“Standalone Monitoring” on page 64</td>
</tr>
</tbody>
</table>

**Colocated Monitoring**

If your computer is directly connected to your StepOne or StepOnePlus instrument by the yellow cable, you can view the progress of the run in realtime as described below. During the run, periodically view all three plots available from the StepOne software for potential problems.

<table>
<thead>
<tr>
<th>#</th>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Stop the run</td>
<td>1. In the StepOne software, click STOP RUN.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. In the Stop Run dialog, click one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Stop Immediately to stop the run immediately.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Stop after Current Cycle/Hold to stop the run after the current cycle or hold.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Cancel to continue the run.</td>
</tr>
<tr>
<td>B</td>
<td>View amplification data in realtime</td>
<td>Select Amplification Plot. See “About the Amplification Plot Screen” on page 59.</td>
</tr>
<tr>
<td>C</td>
<td>View temperature data for the run in realtime</td>
<td>Select Temperature Plot. See “About the Temperature Plot Screen” on page 60.</td>
</tr>
<tr>
<td>D</td>
<td>View progress of the run in the Run Method screen</td>
<td>Select Run Method. See “About the Run Method Screen” on page 61.</td>
</tr>
<tr>
<td>E</td>
<td>Enable/disable the Notification Settings</td>
<td>Select or deselect Enable Notifications. See “(Optional) Enable the Notification Settings” on page 51.</td>
</tr>
</tbody>
</table>

Notes
Chapter 4 Run the Experiment
Monitor the Run

About the Amplification Plot Screen

The Amplification Plot screen allows you to view sample amplification as your instrument collects fluorescence data during a run. If a method is set up to collect real-time data, the Amplification Plot screen displays the data for the wells selected in the View Plate Layout tab. The plot contrasts normalized dye fluorescence (ΔRn) and cycle number. The figure below shows the Amplification Plot screen as it appears during the example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in the View Plate Layout tab.

The Amplification Plot screen is useful for identifying and examining abnormal amplification. Abnormal amplification can include the following:

- Increased fluorescence in negative control wells.

Notes
Absence of detectable fluorescence at an expected cycle (determined from previous similar experiments run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of signal, troubleshoot the error as explained in the StepOne Software Help (click 📕 or press F1).

### About the Temperature Plot Screen

During a run, the Temperature Plot screen displays the temperatures of the sample block(s), the heated cover, and samples (calculated) in realtime. The figure below shows the Temperature Plot screen as it appears during the example experiment.

<table>
<thead>
<tr>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Add/remove temperature plots</td>
<td>Select <strong>Cover</strong> or <strong>Sample Block</strong> to toggle the presence of the associated data in the plot.</td>
</tr>
<tr>
<td>B Change the time displayed by plot</td>
<td>From the <strong>View</strong> dropdown menu, select the amount of time to display in the plot.</td>
</tr>
<tr>
<td>C Display a fixed time window during the instrument run</td>
<td>Select <strong>Fixed View</strong>.</td>
</tr>
</tbody>
</table>

The Temperature Plot screen can be useful for identifying hardware failures. When monitoring the Temperature Plot screen, observe the Sample and Block plots for abnormal behavior.
• In general, the Sample and Block plots should mirror each other approximately. A significant deviation of the plots may indicate a problem.
• The Cover plot should maintain the constant temperature specified in the method. A departure from the constant temperature may indicate a problem.

If you notice an abnormal temperature plot, troubleshoot the error as explained in the StepOne Software Help (click 🎨 or press F1).

**Note:** The Sample temperature displayed in the Current Temperatures group is an estimated value.

### About the Run Method Screen

The Run Method screen displays the run method selected for the run in progress. The software updates the Run Status field throughout the run. The figure below shows the Run Method screen as it appears in the example experiment.

<table>
<thead>
<tr>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Change the number of cycles</td>
<td>In the Adjust # of Cycles field, enter the number of cycles to apply to the Cycling Stage.</td>
</tr>
<tr>
<td>B Add a melt curve stage to the end of the run</td>
<td>Select Add Melt Curve Stage to End.</td>
</tr>
<tr>
<td>C Add a Hold stage to the end of the run</td>
<td>Select Add Holding Stage to End.</td>
</tr>
<tr>
<td>D Apply your changes</td>
<td>Click Send to Instrument.</td>
</tr>
</tbody>
</table>

If an alert appears, click the error for more information and troubleshoot the problem as explained in the StepOne Software Help (click 🎨 or press F1).
Remote Monitor

If your StepOne or StepOnePlus instrument is connected to a network, you can use the Remote Monitor in the StepOne software to view the progress of the run in realtime from any computer on the network.

**IMPORTANT!** Networked computers cannot control the StepOne or StepOnePlus instrument, only monitor it.

To monitor your instrument remotely:

1. In the StepOne software, select Instrument ▶ Remote Monitor.
2. In the navigation pane, select your instrument.
   If the navigation pane does not list your instrument:
   a. Click Add Instrument.
   b. Enter a name for the instrument profile within the Remote Monitor.

   **Note:** Enter any name that helps you identify the instrument. The profile name you enter will be displayed in the Remote Monitor and in the instrument dropdown menus when you send experiments, download experiments, or monitor instruments.

c. In the Instrument Name, Host Name, or IP Address field:
   • If you know the host name, enter the host name.
   • If you do not know the host name, enter the instrument name or IP address.

   **Note:** The instrument name and IP address are displayed on the instrument touchscreen. Go to Settings Menu ▶ Admin Menu ▶ Set Instrument Name or Set IP Address. Contact your systems administrator or information technology department for the host name.

d. Click Save & Exit.

   **Note:** For more information on configuring the StepOne or StepOnePlus instrument for network use or for the Remote Monitor feature, refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide*.
3. Click **Start monitoring the instrument** for your instrument. It may take several minutes for the instrument to send the information to your computer.

4. View data as described below.

<table>
<thead>
<tr>
<th>#</th>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>View amplification data in realtime</td>
<td>Click <strong>Amplification Plot</strong>. See “About the Amplification Plot Screen” on page 59.</td>
</tr>
<tr>
<td>B</td>
<td>View temperature data for the run in realtime</td>
<td>Click <strong>Temperature Plot</strong>. See “About the Temperature Plot Screen” on page 60.</td>
</tr>
<tr>
<td>C</td>
<td>View progress of the run in the Run Method screen</td>
<td>Click <strong>Run Method</strong>. See “About the Run Method Screen” on page 61.</td>
</tr>
<tr>
<td>D</td>
<td>Enable/disable the Notification Settings</td>
<td>Select or deselect <strong>Enable Notifications</strong>. See “(Optional) Enable the Notification Settings” on page 51.</td>
</tr>
</tbody>
</table>
Standalone Monitoring

If you started the run from your StepOne or StepOnePlus instrument, you can view the progress of the run from the touchscreen. The Run Method screen displays the method for the experiment and highlights the thermal profile steps as the instrument performs them.

<table>
<thead>
<tr>
<th>#</th>
<th>To…</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Add a melt curve stage to the run</td>
<td>Touch Add Melt Curve, then touch OK.</td>
</tr>
<tr>
<td>B</td>
<td>Display the time remaining in the run</td>
<td>Touch Display Experiment Time, then touch (\times) to return to the Run Method screen.</td>
</tr>
<tr>
<td>C</td>
<td>Stop the run</td>
<td>Touch STOP, then touch:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Stop to stop the run after the instrument completes the current cycle or hold.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Abort to stop the run immediately.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- (\times) to continue the run with no changes.</td>
</tr>
<tr>
<td>D</td>
<td>View experiment information</td>
<td>Touch View Experiment Information, then touch (\times) to return to the Run Method screen.</td>
</tr>
<tr>
<td>E</td>
<td>View the Error Log</td>
<td>Touch the status bar to display the error log.</td>
</tr>
</tbody>
</table>

Notes
Unload the Instrument and Transfer the Data

When your StepOne or StepOnePlus instrument displays the Main Menu screen, unload the reaction plate from the instrument and transfer the experiment data to the computer for analysis.

**CAUTION** PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the sample block(s) reach room temperature.

**Note:** When the StepOne or StepOnePlus instrument completes a run, the system saves the details of the run to the run history, which remains present in the system until the instrument completes another run.

1. When the Run Report screen appears in the StepOne or StepOnePlus instrument touchscreen, touch.
2. Open the instrument drawer.
3. Remove the reaction plate from the sample block(s).
4. Carefully close the instrument drawer.

**Select a Data Transfer Method**

Transfer the experiment to your computer for analysis according to the layout of your StepOne or StepOnePlus system:

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>The yellow cable connects the computer and the instrument.</td>
<td>“Colocated Data Transfer” below</td>
</tr>
<tr>
<td>Standalone (Networked)</td>
<td>The computer and the instrument are connected to the same network.</td>
<td>“Remote Data Transfer” on page 66</td>
</tr>
<tr>
<td>Standalone (Basic)</td>
<td>The computer and the instrument are not connected.</td>
<td>“Standalone Data Transfer” on page 67</td>
</tr>
</tbody>
</table>

**Notes**
Colocated Data Transfer

If your computer is directly connected to your StepOne or StepOnePlus instrument by the yellow cable, no action is necessary. The StepOne software automatically transfers the experiment data from the instrument to the computer after the run.

Note: In a colocated layout, you can start the run from the computer or from the instrument touchscreen. However, the StepOne software only transfers the experiment data automatically when a run is started from the computer (see “Colocated Startup” on page 54).

Remote Data Transfer

If your computer and StepOne or StepOnePlus instrument are connected to the same Ethernet network, download the experiment from the instrument over the network:

1. In the StepOne software, click Download Experiment from Instrument to open the Download Experiment from Instrument dialog box.
2. From the Select Instrument dropdown menu, select your instrument.
3. From the Experiment dropdown menu, select the example experiment file.
4. In the Download File To field:
   a. Click Browse.
   b. Navigate to:
      
      \<drive>\Applied Biosystems\<software name>\experiments\ where:
      
      \<drive> is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
      \<software name> is the current version of the StepOne software.
   c. Click Select.
5. Click Download Experiment to download the example experiment file from your instrument to your computer over the network.
6. When prompted, click OK to close the confirmation.
**Standalone Data Transfer**

If your computer is not connected to your StepOne or StepOnePlus instrument, use the USB drive to transfer the experiment from the instrument to the computer:

1. If not already connected to the instrument, connect a USB drive to the USB port.

2. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

   **Note:** If the touchscreen is not at the Main Menu screen, touch 🎯.

3. Wait for the USB sign to appear on the touchscreen.

4. In the Main Menu, touch **Collect Results** to save the data to the USB drive.

   **Note:** If your instrument cannot find the USB drive, remove the USB drive, then try again. If the instrument still does not recognize the USB drive, try another USB drive.

5. When prompted that the data has been transferred successfully, touch **OK**.

6. Remove the USB drive from your instrument, then connect it to one of the USB ports on your computer.

7. In the computer desktop, use the Windows explorer open the USB drive.
8. Copy the example experiment file to:
   \<drive>\Applied Biosystems\<software name>\experiments\ where:
   • \<drive> is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
   • \<software name> is the current version of the StepOne software.
Chapter 5

Analyze the Experiment

This chapter covers:

- Chapter Overview ................................................................. 70
- Open the Experiment for the Analysis .................................... 71
- View the Allelic Discrimination Plot ....................................... 73
- View the Plate Layout ............................................................... 76
- View the Well Table ................................................................. 78
- View the QC Summary .............................................................. 81
- View the Raw Data Plot ............................................................ 82
- View the Multicomponent Plot ................................................ 84
- View the Amplification Plot ...................................................... 86
- View the Analysis Settings ...................................................... 93
- Publish the Data ...................................................................... 98

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing F1, clicking Help in the toolbar, or selecting Help ▶ StepOne Software Help.
Chapter Overview

This chapter explains how to view, analyze, and publish the analyzed experiment.

Workflow

Start Experiment

Design the Experiment (Chapter 2)

Prepare the Reactions (Chapter 3)

Run the Experiment (Chapter 4)

Analyze the Experiment (Chapter 5)
1. View the allelic discrimination plot.
2. View the plate layout.
3. View the results in a table.
4. View the quality summary.
5. View the raw data plot.
6. View the multicomponent plot.
7. View the amplification plot.
8. View the analysis settings.
9. Publish the data.

End Experiment

How to Evaluate the Results

Review of the results occurs in three steps:

1. Perform an initial review of the Allelic Discrimination Plot (see page 73), the plate layout (see page 76), and the well table (see page 78) to evaluate the genotype calls made by the StepOne software.

2. Perform a thorough review of the QC Summary (see page 81) to evaluate the samples that triggered QC flags. Review the raw data (see page 82) and amplification data (see page 86) for the samples that exhibit abnormal amplification.

3. If necessary, define the analysis settings (see page 93) or modify the calls manually (see page 97).

After evaluating the results, you can publish the results as explained in “Publish the Data” on page 98.
Open the Experiment for the Analysis

Prepare for the analysis by opening the experiment.

**About the Example Experiment**

For the genotyping example experiment, use the data file that installs with the StepOne software. The data file was created with the same design parameters provided in Chapter 2, then run and analyzed on a StepOne™ instrument.

You can find the data file for the example experiment on your computer:

```markdown
<drive>:\Applied Biosystems\<software name>\experiments\examples\Genotyping Example.eds
```

where:

- `<drive>` is the computer hard drive on which the StepOne software is installed. The default installation drive for the software is the D drive.
- `<software name>` is the current version of the StepOne software.

**Open the Experiment**

1. Double-click (StepOne software) or select **Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ `<software name>`**

   where `<software name>` is the current version of the StepOne software.

2. In the Login dialog box, select **EXAMPLEUSER** from the User Name dropdown menu, then click **OK**.

   **Note:** EXAMPLEUSER is the user name you created when you designed the genotyping experiment (page 17).

3. From the Home screen, click **Open**.

4. In the Open dialog box, navigate to the **examples** folder:

   ```markdown
   <drive>:\Applied Biosystems\<software name>\experiments\examples
   ```

5. Double-click **Genotyping Example** to open the example experiment data file.

   **Note:** The examples folder contains several data files; be sure to select **Genotyping Example**. For information on the other data files, see “Data Files in the Examples Folder” on page 12.
For more information, access the StepOne Software Help by clicking or pressing F1.
**View the Allelic Discrimination Plot**

Perform an initial review of the experiment results in the Allelic Discrimination Plot, which contrasts the normalized reporter dye fluorescence ($R_n$) for the allele-specific probes of the SNP assay. See “Reading and Analyzing the Plates” on page 8 for a complete description of the plot.

**About the Example Data**

For the example experiment, confirm that the Allelic Discrimination Plot displays:
- Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2 homozygous, and Allele 1/2 heterozygous)
- A cluster for the negative controls

**Review the Plot**

1. From the Experiment Menu pane, select Analysis ➔ Allelic Discrimination Plot.

   **Note:** If no data are displayed, click Analyze.

2. Click the View Plate Layout tab, then click any empty well to select it.

   **Note:** In the Allelic Discrimination Plot, the software highlights all wells that are selected in the View Plate Layout tab. If the plot displays a single color for all wells, then all wells in the plate layout are selected.

3. In the amplification plot, select C__11711420_30 from the SNP Assay menu.

   - If the Autocaller is enabled, the Allelic Discrimination Plot displays allele symbols for each sample evaluated for the selected SNP.
   
   The samples are grouped on the plot as follows:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Are grouped along the...</th>
<th>The genotypes of the samples are...</th>
</tr>
</thead>
<tbody>
<tr>
<td>• (red)</td>
<td>X-axis of the plot</td>
<td>Homozygous for Allele 1 of the selected SNP assay.</td>
</tr>
<tr>
<td>• (blue)</td>
<td>Y-axis of the plot</td>
<td>Homozygous for Allele 2 of the selected SNP assay.</td>
</tr>
<tr>
<td>• (green)</td>
<td>Midway between the homozygote clusters</td>
<td>Heterozygous for both alleles of the selected SNP assay (Allele 1 and Allele 2).</td>
</tr>
<tr>
<td>■ (black)</td>
<td>Bottom-left corner of the plot</td>
<td>A negative control.</td>
</tr>
<tr>
<td>× (black)</td>
<td>Anywhere on plot</td>
<td>Undetermined.</td>
</tr>
</tbody>
</table>

   - If the Autocaller is not enabled, the Allelic Discrimination Plot displays a crossmark (× – Undetermined) for each sample.

4. For each cluster in the plot:

   a. Click and drag a box around the cluster to select the associated wells in the plate layout and well table.

**Notes**
b. Confirm that the expected wells are selected in the well table.
   For example, if you select the cluster at the bottom-left corner of the plot, only the negative controls should be selected. The presence of an unknown among the negative controls may indicate that the sample failed to amplify.

c. Repeat steps 4a and 4b for all other clusters in the plot.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNP Assay dropdown menu</td>
<td>Determines the SNP assay data that the StepOne software displays in the plot.</td>
</tr>
<tr>
<td>Plot Type dropdown menu</td>
<td>Determines the type of plot (Cartesian or Polar) that the StepOne software will use to display the data.</td>
</tr>
<tr>
<td>Apply Call dropdown menu</td>
<td>When a datapoint is selected, this menu allows you to assign an allele call to the datapoint within the scatterplot.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Contains tools for manipulating the scatterplot:</td>
</tr>
<tr>
<td></td>
<td>- Selects datapoints by clicking individual datapoints, or by clicking and dragging a box around a group of datapoints.</td>
</tr>
<tr>
<td></td>
<td>- Selects datapoints by encircling them.</td>
</tr>
<tr>
<td></td>
<td>- Repositions the scatterplot.</td>
</tr>
<tr>
<td></td>
<td>- Magnifies the scatterplot.</td>
</tr>
<tr>
<td></td>
<td>- Zooms out the scatterplot.</td>
</tr>
<tr>
<td>Legend</td>
<td>An explanation of the symbols in the scatterplot.</td>
</tr>
</tbody>
</table>

The figure below shows the Allelic Discrimination Plot of the example experiment.
When you analyze your own experiment:

- Confirm that all controls have the correct genotype.
- If using positive controls, confirm the calls for the positive controls:
  a. From the well table, select the wells containing a positive control to highlight the corresponding datapoints in the Allelic Discrimination Plot.
  b. Check that the datapoints for the positive controls cluster along the expected axis of the plot. For example, if you select the Positive Control Allele 1/Allele 1, then the controls should cluster along the X-axis.
  c. Repeat steps a and b for the wells containing the other positive controls.
- Screen the negative control cluster for unknown samples that failed to amplify:
  a. Select the datapoints of the cluster in the lower left corner of the Allelic Discrimination Plot to select the corresponding wells in the well table.
  b. Check that the selected wells in the well table are negative controls, and not unknown samples.
- Samples that clustered with the negative controls may:
  – Contain no DNA
  – Contain PCR inhibitors
  – Be homozygous for a sequence deletion
- Confirm the results of the samples that did not cluster tightly or are clustered with negative controls by retesting them.
- If you select to run replicate reactions, carefully review your data set for outliers to ensure the accuracy of the genotype calls. If outliers are present, confirm the results of the associated samples by retesting them.
- Observe the number of clusters in the plot. If the Allelic Discrimination Plot contains less than the three representative genotype clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then the StepOne software may not be able to genotype the samples until you enable the 2-Cluster Calling feature.

If the plot contains less than three clusters:

a. Click Analysis Settings.

b. Click Edit Default SNP Assay Settings.

c. Select 2-Cluster Calling Enabled, then click Save Changes.

d. Click Apply Analysis Settings.

e. Click Reanalyze to reanalyze the experiment using 2-Cluster Calling.

Note: The results displays are synchronized. For example, selecting a well in the plate layout selects the corresponding data in the well table and Allelic Discrimination Plot.
View the Plate Layout

Review the experiment results in the plate layout. The plate layout displays the assay-specific setup and analysis properties for the experiment in a well format corresponding to the type of reaction plate used for the run.

About the Example Data

For the example experiment, confirm that the StepOne software called:

- 6 samples as Allele 1 homozygous (●)
- 4 samples as Allele 2 homozygous (●)
- 12 samples as heterozygous (●)
- 2 samples as negative controls (■)

Confirm that no wells of the reaction plate triggered QC flags (▲).

View the Layout

1. Click the < icon beside the Allelic Discrimination Plot to maximize the plate layout.
2. Click Show in Wells, then select or deselect a parameter that you want the wells to display.
3. Repeat step 2 until the plate layout contains all of the desired parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Name</td>
<td>The name of the sample applied to the well.</td>
</tr>
<tr>
<td>Task</td>
<td>The task assigned to the well:</td>
</tr>
<tr>
<td></td>
<td>- Unknown</td>
</tr>
<tr>
<td></td>
<td>- Negative Control</td>
</tr>
<tr>
<td></td>
<td>- Positive Control</td>
</tr>
<tr>
<td>SNP Assay Name</td>
<td>The name of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Assay ID</td>
<td>The Assay ID number of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Allele 1 / Allele 2</td>
<td>The name of the associated allele for the SNP evaluated by the well</td>
</tr>
<tr>
<td>Allele 1 Dyes / Allele 2 Dyes</td>
<td>The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well</td>
</tr>
<tr>
<td>SNP Assay Color</td>
<td>The color of the SNP evaluated by the well.</td>
</tr>
<tr>
<td>Sample Color / Task Color</td>
<td>The color of the sample or task applied to the well.</td>
</tr>
<tr>
<td>Genotype Call</td>
<td>The allele call assigned to the sample:</td>
</tr>
<tr>
<td></td>
<td>- Homozygous 1/1</td>
</tr>
<tr>
<td></td>
<td>- Homozygous 2/2</td>
</tr>
<tr>
<td></td>
<td>- Heterozygous 1/2</td>
</tr>
<tr>
<td></td>
<td>- Negative Control</td>
</tr>
<tr>
<td></td>
<td>- Undetermined</td>
</tr>
<tr>
<td>Flag</td>
<td>The number of QC flags the well triggered as listed in the ▲ symbol.</td>
</tr>
</tbody>
</table>
Chapter 5 Analyze the Experiment

View the Plate Layout

The following figure shows the plate layout of the example genotyping experiment.

Analysis Guidelines

When you analyze your own experiment:

- The plate layout displays `X` in the top-left corner of wells omitted by the user; it displays ` ▲ ` in the corner of wells omitted by the QC flag settings.
- Note the location of any samples that trigger QC flags (▲). Understanding the position of errors can aid in diagnosing any failures that may occur.
- You can select the entire reaction plate, areas of the reaction plate, or specific wells:
  - Click the upper left corner of the reaction plate to select all 48 wells.
  - Left-click the mouse and drag across the area to select it.
  - Select Sample, Target, or Task from the Select Items menu in the View Plate tab. Then select the sample, target, or task name from the second Select Items menu to select wells of a specific type using the well-selection tool.
- You can adjust the plate layout:
  - Use the (Zoom In), (Zoom Out), and (Fit All) buttons to increase or decrease the wells shown.
  - Use the arrow tabs to expand the plate layout to cover the entire screen.

For More Information

For more information on the plate layout, access the StepOne Software Help by clicking ( ) or pressing F1.

Notes
View the Well Table

Review the details of the experiment results in the well table and identify any flagged wells. The well table displays the assay-specific setup and analysis properties for the experiment in a table format.

About the Example Data

For the example experiment, confirm that no wells of the reaction plate triggered QC flags (▲).

Review the Table

1. Select the View Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags appear at the top of the table.

3. Confirm the integrity of the controls:
   a. From the Group By menu, select Task to organize the table rows by their function on the reaction plate.
   b. Confirm that each of the controls do not display flags (▲).
   c. Click the – icons to collapse the negative and positive controls.

4. Click > beside the View Well Table tab to display the Allelic Discrimination Plot and the well table simultaneously.

The figure below shows the well table of the example genotyping experiment.

![Well Table Screenshot]

Column Description

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>The position of the well on the reaction plate.</td>
</tr>
<tr>
<td>Omit</td>
<td>A check mark indicates that the well has been removed from the analysis.</td>
</tr>
<tr>
<td>Flag</td>
<td>▲ indicates that the well triggered the number of flags listed inside the symbol.</td>
</tr>
<tr>
<td>Sample Name</td>
<td>The name of the sample.</td>
</tr>
<tr>
<td>SNP Assay Name</td>
<td>The name of the SNP assay evaluated by the well.</td>
</tr>
<tr>
<td>Assay ID</td>
<td>The Assay ID number of the SNP evaluated by the well.</td>
</tr>
</tbody>
</table>

Notes
**Column** | **Description**
---|---
Task | The task assigned to the well (Unknown, Negative Control, or Positive Control).
Allele 1 / 2 | The name of the associated allele for the SNP evaluated by the well.
Allele 1 / 2 Dyes | The name of the reporter and quencher dyes of the associated allele for the SNP evaluated by the well.
Allele 1 / 2 R\textsubscript{n} | Normalized signal (R\textsubscript{n}) of the reporter dye of the associated allele for the SNP evaluated by the well.
Pass Ref | The signal of the passive reference dye for the well.
Call | The allele call assigned to the sample, where possible calls are:
- ● Homozygous 1/1 - Homozygous for allele 1
- ● Homozygous 2/2 - Homozygous for allele 2
- ● Heterozygous 1/2 - Heterozygous
- ■ Negative Control
- ✗ Undetermined
Quality(%) | The quality value calculated for the genotype call.
Method | The method used to assign the call to the sample (Auto if assigned by the StepOne software, or Manual if applied by a user).
Comments | Comments entered for the associated sample well.
Allele 1 / 2 C\textsubscript{T} | Threshold cycle (C\textsubscript{T}) of the sample for the associated allele for the SNP evaluated by the well.

**QC Flag Columns**
The well table displays columns for QC flags that are triggered by the experimental data. If the experiment data does not trigger a QC flag, then the StepOne software does not display a corresponding column for the flag.

A ▲ in one of the following columns indicates that the associated well triggered the flag.

BADROX | The well produced a passive reference signal greater than the limit defined in the analysis settings.
OFFSCALE | The well produced a level of fluorescence greater than the StepOne or StepOnePlus system can measure.
NOSIGNAL | The well did not produce a detectable level of fluorescence.
CLUSTER# | For the SNP evaluated by the well, the number of clusters generated from the experiment data is greater than the limit defined in the analysis settings.
PCFAIL | The positive control did not produce an R\textsubscript{n} for the associated allele greater than the limit defined in the analysis settings indicating that the control may have failed to amplify.
SMCLUSTER | The number of data points in the associated cluster is less than the limit defined in the analysis settings.
AMPNC | The negative control has produced an R\textsubscript{n} greater than the limit defined in the analysis settings indicating possible amplification.
NOAMP | The well did not produce an R\textsubscript{n} for either allele that is greater than the limit defined in the analysis settings indicating that the well may have failed to amplify.
NOISE | The background fluorescence (noise) produced by the well is greater than the other wells on the reaction plate by a factor greater than the limit defined in the analysis settings.
SPIKE | The amplification plot for the well contains one or more data points inconsistent with the other points in the plot.
Chapter 5  Analyze the Experiment
View the Well Table


Analysis Guidelines

When you analyze your own experiment:

- If you are using positive controls, also confirm the integrity of the positive controls:
  a. From the Group By menu, select Task to organize the table rows by their function on the reaction plate.
  b. Confirm that the positive controls do not display flags (▲) and that their normalized reporter dye fluorescence (R_n) is appropriate for the genotype (for example, if evaluating the Positive Control Allele 1/Allele 1, you would expect to see significant increase in R_n for the Allele 1 probe and very little for the Allele 2 probe).
  c. Repeat step b for each positive control.

- Review the data for the Unknown samples. For each row that displays ▲ in the Flag column, note the data and the flag(s) triggered by the associated well.

- Select areas of the table or wells of a specified type by:
  - Left-clicking the mouse and dragging across the area you want to select an area of the table.
  - Selecting Sample, Target, or Task from the Select Items menu in the View Table tab, then selecting the sample, target, or task name from the second Select Items menu to select wells of a specific type using the well-selection tool.

- Group the rows of the plate layout by selecting an option from the Group By menu. You can then collapse or expand the lists either by clicking the +/- icon next to individual lists, or by clicking Collapse All or Expand All.

- Omit a well from the analysis by selecting the Omit check box for that well. To include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.

For More Information

For more information on the well table, access the StepOne Software Help by clicking or pressing F1.

Notes
View the QC Summary

Review the summary of the QC flags triggered by the experiment data and troubleshoot the flags. The QC summary displays a frequency and location of all QC flags. If a flag does not appear in the experiment, its frequency is 0. If the frequency is not 0, that flag appears at the well position listed in the location column. Clicking a flag displays the flag details, including a list of all flagged wells.

About the Example Data

In the genotyping example experiment, you review the QC Summary screen for any flags triggered by the experiment data. In the example experiment, no flags have been triggered.

Review the Summary

1. In the navigation column, select QC Summary.

2. Review the Flag Summary. In the example experiment, there are 0 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine which flags appear in the experiment. In the example experiment, the Frequency column displays 0 for all flags.

   Note: A 0 displayed in the Frequency column indicates that the flag does not appear in the experiment.

4. (Optional) Click each flag row to display detailed information about the flag.
Chapter 5  Analyze the Experiment

View the Raw Data Plot

Analysis Guidelines

When you analyze your own experiment:

- Select each QC flag in the Flag Details with a frequency greater than 0, review the frequency and location of the wells that triggered the QC flag, then click the link for troubleshooting the flag.

  Note: When you select a flag in the Flag Details table, the well table highlights the wells that triggered the flag.

For More Information

For more information on the QC Flags, access the StepOne Software Help by clicking 📚 or pressing F1.

View the Raw Data Plot

If necessary, review the Raw Data Plot for irregularities in the raw spectra collected by the StepOne™ or StepOnePlus™ instrument.

The Raw Data Plot displays the amplitude of the raw fluorescence collected in each channel (1 through 3) during the run cycle indicated by the Show Cycle slider. The plot displays the raw spectra for the wells selected in the plate layout or the well table.

About the Example Data

In the example experiment, review the Raw Data Plot screen for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.

Review the Plot

1. In the navigation pane, select 📂 Raw Data Plot.

2. In the well table, select the wells that you want to inspect.

3. Click 🔍 Show a legend for the plot (default).

  Note: This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

  Note: The legend displays the color code for each row of the reaction plate.
4. Drag the Show Cycle slider to view temporal changes in each filter of the raw data profile. The filters are:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Dye</th>
<th>Filter</th>
<th>Dye</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FAM™ dye</td>
<td>1</td>
<td>FAM™ dye</td>
</tr>
<tr>
<td></td>
<td>SYBR® Green dye</td>
<td></td>
<td>SYBR® Green dye</td>
</tr>
<tr>
<td>2</td>
<td>JOE™ dye</td>
<td>2</td>
<td>JOE™ dye</td>
</tr>
<tr>
<td></td>
<td>VIC® dye</td>
<td></td>
<td>VIC® dye</td>
</tr>
<tr>
<td>3</td>
<td>ROX™ dye</td>
<td>3</td>
<td>TAMRA™ dye</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NED™ dye</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>4</td>
<td>ROX™ dye</td>
</tr>
</tbody>
</table>

The figure below shows raw data from the example genotyping experiment.

**Analysis Guidelines**

When you analyze your own experiment, look for the following in each filter:

- Characteristic signal growth
- No abrupt changes or dips

**For More Information**

For more information on the Raw Data Plot, access the StepOne Software Help by clicking or pressing F1.
View the Multicomponent Plot

The Multicomponent Plot displays the complete spectral contribution of each dye in a selected well over the duration of the PCR run.

About the Example Data

In the example experiment, review the Multicomponent Plot for:

- ROX™ dye (passive reference)
- FAM™ dye (reporter)
- Spikes, dips, and/or sudden changes
- Amplification in the negative control wells

View the Multicomponent Plot

1. In the navigation column, select Multicomponent Plot.
2. Select one unknown well in the plate layout to display the corresponding data in the Multicomponent Plot.
   
   **Note:** If you select multiple wells, the Multicomponent Plot screen displays the data for all selected wells simultaneously.

3. From the Plot Color dropdown menu, select Dye.
4. Click Show a legend for the plot (default).
   
   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

5. Check the FAM™ and VIC® dye signals. In the example experiment, the FAM™ and VIC® dye signals increase throughout the PCR, indicating normal amplification.
6. Check the ROX® dye signal. In the example experiment, the ROX dye signal remains constant throughout the PCR process, which indicates typical data.
7. Select the negative control wells one at time and check for amplification. In the example experiment, there is no amplification in the negative control wells.
Chapter 5  Analyze the Experiment

View the Multicomponent Plot

Analyze the Experiment

Notes

Analysis Guidelines

When you analyze your own experiment, look for:

- Passive reference – The passive reference dye fluorescence level should remain relatively constant throughout the PCR process.
- Reporter dye – The reporter dye fluorescence level should display a flat region corresponding to the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.
- Any irregularities in the signal – There should not be any spikes, dips, and/or sudden changes in the fluorescent signal.
- Negative control wells – There should not be any amplification in the negative control wells.

For More Information

For more information on the Multicomponent Plot, access the StepOne Software Help by clicking or pressing F1.
View the Amplification Plot

If you collected real-time data for your experiment, review the amplification data to further understand the flags triggered by the experiment data.

The Amplification Plot screen displays amplification of all samples in the selected wells. Use the amplification plots to confirm the results of the experiment:

- **ΔRn vs Cycle** – ΔRn is the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. This plot displays ΔRn as a function of cycle number. You can use this plot to identify and examine irregular amplification and to view threshold and baseline values for the run.

- **Rn vs Cycle** – Rn is the fluorescence signal from the reporter dye normalized to the fluorescence signal from the passive reference. This plot displays Rn as a function of cycle number. You can use this plot to identify and examine irregular amplification.

- **CT vs Well** – CT is the PCR cycle number at which the fluorescence meets the threshold in the amplification plot. This plot displays CT as a function of well position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as the following graph types: linear or log10.

---

**Note:** For more information about the Amplification Plots, refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide* or the StepOne Software Help.

---

**About the Example Data**

In the example experiment, review the Amplification Plot for:

- Correct baseline and threshold values
- Outliers

**Review the Results**

1. In the navigation column, select **Amplification Plot**.

2. In the Amplification Plot:
   
   a. From the Plot Type dropdown menu, select **ΔRn vs Cycle**.
   
   b. From the Plot Color dropdown menu, select **Allele**.
   
   c. Click **Show a legend for the plot** (default).

   **Note:** This is a toggle button. When the legend is displayed, the button changes to Hide the plot legend.

3. View the baseline values:
   
   a. From the Graph Type dropdown menu, select **Linear**.
   
   b. Select **Baseline** to show the start cycle and end cycle.

---

Notes
c. Verify that the baseline is set correctly: The end cycle should be set a few cycles before the cycle number where significant fluorescent signal is detected. In the example experiment, the baseline is set correctly.

4. View the threshold values:
   a. From the Graph Type dropdown menu, select Log.
   b. From the Target dropdown menu, select C__11711420_30-A.
   c. Select Threshold to show the threshold.
   d. Verify that the threshold is set correctly. In the example experiment, the threshold is in the exponential phase.
   e. Repeat steps 4a through 4d for C__11711420_30-C.
5. Locate any outliers:
   
   a. From the Plot Type dropdown menu, select $C_T$ vs Well.
   
   b. Confirm that the replicate wells have achieved similar amplification. The example experiment does not use replicate wells.

Analysis Guidelines

When you analyze your own experiment, look for:

- Outliers
  
  A typical amplification plot – The StepOne software automatically calculates baseline and threshold values based on the assumption that the data exhibit a typical amplification plot. A typical amplification plot has four distinct sections:

  a. Plateau phase
  
  b. Linear phase
  
  c. Exponential (geometric phase)
  
  d. Baseline
IMPORTANT! Experimental error (such as contamination or pipetting errors) can produce atypical amplification curves that can result in incorrect baseline and threshold value calculations by the StepOne software. Therefore, Applied Biosystems recommends that you examine the Amplification Plot screen and review the assigned baseline and threshold values for each well after analysis completes. For more information, see the StepOne™ Software Help.

- Correct baseline and threshold values – See the threshold examples on page 90 and the baseline examples on page 91.
**Threshold Set Correctly**

The threshold is set in the exponential phase of the amplification curve.

Threshold settings above or below the optimum increase the standard deviation of the replicate groups.

**Threshold Set Too Low**

The threshold is set below the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar up into the exponential phase of the curve.

**Threshold Set Too High**

The threshold is set above the exponential phase of the amplification curve. The standard deviation is significantly higher than that for a plot where the threshold is set correctly. Drag the threshold bar down into the exponential phase of the curve.
Baseline Set Correctly

The amplification curve begins after the maximum baseline.

Baseline Set Too Low

The amplification curve begins too far to the right of the maximum baseline. Increase the End Cycle value.

Baseline Set Too High

The amplification curve begins before the maximum baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above, troubleshoot as follows:

- Manually adjust the baseline and/or threshold (see the StepOne Software Help).
  
  or

- Omit a well by right-clicking the well in the plate layout and selecting **Omit.**
How to View Multiple Plots Simultaneously

The multiple plot view displays up to four plots for simultaneous analysis. You can view each plot individually, two plots as rows or columns, or all plots in a 2 × 2 matrix.

To review the results in multiple plots:

1. In the navigation column, select **Multiple Plots View**.
2. Click to display two plots in parallel.
3. In the top plot, select **Amplification Plot (ΔR₀ vs. Cycle)** to view results of the amplification run for each well selected in the plate layout.
4. In the bottom plot, select **Raw Data Plot** to view the raw data for each well selected in the plate layout.

For More Information

For more information on the Amplification Plot or on the Multiple Plot View, access the StepOne Software Help by clicking or pressing F1.
View the Analysis Settings

If you are dissatisfied with how the StepOne software is calling genotypes or the thresholds of the QC flags, review and adjust the analysis settings and/or calls as needed.

About the Example Data

In the example experiment, review and adjust the analysis settings as desired to learn how the call, C_T, and flag settings contribute to the analysis of the genotyping data.

Modify the Analysis Settings

1. In the experiment, click Analysis Settings.

2. Adjust the call settings:
   a. Select the Call Settings tab.
   b. Select the C__11711420_30 from the Select a SNP Assay table.
   c. Click Edit Default Settings.
   d. If you have made manual calls, select Keep Manual Calls from Previous Analysis in the Edit Default Call Settings dialog box.
   e. In the Quality Value field, enter a percentage value to apply as the quality interval for autocalling samples. The greater the value, the more stringent the allele calling.
   f. Click Save Changes to save your settings.

3. Adjust the C_T settings:
   a. Select the C_T Settings tab.
   b. Select allele A from the Select an Allele table
   c. Deselect Use Default Settings
d. Deselect **Automatic Threshold**, then enter a new threshold value.

e. Deselect **Automatic Baseline**, then enter new baseline values.

f. Repeat steps 3b through 3e for allele C.

**Note:** For more information on setting the threshold cycles for genotyping runs, see the StepOne Software Help.

---

4. Adjust the flag settings:

   a. Select the **Flag Settings** tab.

   b. In the Use column, select the check box of each flag that you want to enable.

   c. Adjust the value(s) for the enabled flags as needed.

   d. If you want an enabled QC flag to automatically omit wells that test positive for the condition it defines, select the Reject Well check box for the flag.

**Note:** The QC flags allow you to flag conditions and omit wells when certain criteria are met (for example, when a well has missing data). For more information, see the StepOne Software Help.
5. Click **Apply Analysis Settings**.

6. Click **Reanalyze** to analyze the data using the new settings.

**Analysis Guidelines**

When you analyze your own experiment:

- If your experiment consists of only two clusters, activate the 2-Cluster Calling algorithm by selecting **2-Cluster Calling Enabled** from the Edit Default SNP Assay Settings dialog box.
- The **C_T** Settings are available only for experiments that include amplification data. Experiments that consist only of Pre- and Post-PCR reads do not use the threshold cycle (**C_T**) system for analysis.
- You can call sample data:
  - Automatically, using the Autocaller (see page 96)
  - Manually, using the toolbar and scatterplot (see page 97)

**For More Information**

For more information on the Analysis Settings, access the StepOne Software Help by clicking 📖 or pressing F1.
Assign Calls Automatically

1. In the experiment, click **Analysis Settings**.
2. Select the desired SNP Assay from the Select a SNP Assay table.
3. Click **Edit Default Settings**.
4. If you have made manual calls, select **Keep Manual Calls from Previous Analysis**.
5. Select **Autocaller Enabled** to activate automatic analysis.
6. If you expect the analyzed data to consist of only two clusters, select **2-Cluster Calling Enabled**.
7. In the Quality Value field, enter a percentage value to apply as the quality interval for auto-calling samples. (The greater the value, the more stringent the allele calling.)
8. Click **Save Changes** to save your settings.
9. (Optional) Assign flags:
   a. Select the **Flag Settings** tab.
   b. Assign flags as desired.

   **Note:** When you assign flags, you can flag conditions and omit wells when certain criteria are met (for example, when a well has missing data). For more information, see the **StepOne™ Software Help**.

   c. Click **Apply Analysis Settings** to close the Analysis Settings dialog box.
10. Click **Reanalyze** to analyze the data using the new settings.
Assign Calls Manually

1. In the experiment, click **Analysis Settings**.

2. Select the desired SNP Assay from the Select a SNP Assay table.

3. Set the marker analysis settings:
   a. Click **Edit Default Settings**.
   b. Deselect the **Autocaller Enabled**.
   c. Click **Save Changes** to save your settings.

4. (Optional) Assign flags:
   a. Select the **Flag Settings** tab.
   b. Assign flags as desired.

   **Note**: When you assign flags, you can flag conditions and omit wells when certain criteria are met (for example, when a well has missing data). For more information, see the *StepOne™ Software Help*.

   c. Click **Apply Analysis Settings**.

5. Click **Reanalyze** to analyze the data using the new settings.

6. In the navigation column, select **Allelic Discrimination Plot**.

7. Select a marker from the SNP Assay menu. Crossmarks (× – Undetermined) representing the selected marker are displayed in the Allelic Discrimination Plot.

8. To assign calls:
   a. Click (selection tool).
   b. Click-drag a box around the desired data points in the plot.
   c. In the Apply Call menu, select the desired call.
   d. Repeat steps 8b and 8c to apply calls to the rest of the datapoints.

9. If you are assigning calls for multiple SNPs, select a different marker from the SNP assay dropdown menu and repeat step 8.
Chapter 5  Analyze the Experiment
Publish the Data

You can publish the experiment data in several ways:

• Save the plot as an image file
• Print the plot
• Print the plate layout
• Create slides
• Print a report
• Export data

For more information publishing data, access the StepOne Software Help by clicking or pressing F1.
Alternate Experiment Workflows

This appendix covers:

- Advanced Setup Workflow ..................................................... 100
- QuickStart Workflow .............................................................. 101
- Template Workflow ............................................................... 103
- Export/Import Workflow ......................................................... 105

Note: For more information about any of the topics discussed in this guide, access the Help from within Applied Biosystems StepOne™ Real-Time PCR Software by pressing F1, clicking ⬆️ in the toolbar, or selecting Help ➔ StepOne Software Help.
Advanced Setup Workflow

When you create an experiment using Advanced Setup in the StepOne™ software, you can set up the experiment according to your own design.

1. Double-click (StepOne software) or select Start ➤ All Programs ➤ Applied Biosystems ➤ StepOne Software ➤ <software name>
   where <software name> is the current version of the StepOne software.

2. Log in with a user name or as a Guest.

3. From the Home screen, click Advanced Setup.

   Note: If you do not see the Advanced Setup icon, click the arrow beneath the Design Wizard icon to expand the Set Up menu.

4. Complete the setup screens to set up a new experiment:
   a. Click Experiment Properties (default), enter the experiment name, then select the experiment properties.
   b. Click Plate Setup:

      | Experiment Type         | Action                                      |
      |-------------------------|---------------------------------------------|
      | Genotyping              | Define the SNP assays, then assign them to wells in the reaction plate. |
      | All other experiments   | Define the targets, then assign them to wells in the reaction plate. |

   c. Click Run Method, review the reaction volume and thermal profile, then edit as needed.
   d. Click Reaction Setup, review the components and calculated volumes for the PCR reactions, then edit as needed.
   e. (Optional) Click Materials List, review the list of materials, then order the materials you need to prepare the reaction plate.

5. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Standard curve</td>
<td></td>
</tr>
</tbody>
</table>
Appendix A  Alternate Experiment Workflows

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Comparative $C_T$</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td>Genotyping</td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>c. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>

6. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.

7. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click **Analysis**.
   c. If the data are not analyzed, click **Analyze**.
   d. In the navigation pane, select an analysis screen to view the data (for example, select **QC Summary** to view a quality summary of the data).
2. QuickStart the experiment:
   a. Double-click  (StepOne software) or select Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ <software name>
      where <software name> is the current version of the StepOne software.
   b. Log in with a user name or as a Guest.
   c. From the Home screen, click QuickStart.
   d. Select the Experiment Properties tab (default), enter the experiment name, then select the experiment properties.
   e. Select the Run Method tab, review the reaction volume and thermal profile, then edit as needed.

3. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.

4. In the StepOne software, complete the plate setup:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genotyping</td>
<td>a. Select and complete the Define SNP Assays and Samples tab.</td>
</tr>
<tr>
<td></td>
<td>b. Select and complete the Assign SNP Assays and Samples tab.</td>
</tr>
<tr>
<td>All other experiments</td>
<td>a. Select and complete the Define Targets and Samples tab.</td>
</tr>
<tr>
<td></td>
<td>b. Select and complete the Assign Targets and Samples tab.</td>
</tr>
</tbody>
</table>

5. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click Analysis.
   c. If the data are not analyzed, click Analyze.
   d. In the navigation pane, select an analysis screen to view the data (for example, select QC Summary to view a quality summary of the data).
**Template Workflow**

You can use a template to create a new experiment. Templates are useful when you want to create many experiments with the same setup information.

**Create a Template**

1. Double-click (StepOne software) or select **Start** ➤ **All Programs** ➤ **Applied Biosystems** ➤ **StepOne Software** ➤ `<software name>`
   
   where `<software name>` is the current version of the StepOne software.
2. Log in with a user name or as a Guest.
3. Open an existing experiment, or create a new experiment.
   
   **Note:** You can create a new experiment using the Design Wizard (see Chapter 2) or Advanced Setup (see page 100).
4. Select **File** ➤ **Save As Template**.
5. Enter a file name, select a location for the template, then click **Save**.
6. Click **Close**.

**Create an Experiment with a Template**

1. From the Home screen, click **Template**.
   
   **Note:** If you do not see the Template icon, click the arrow beneath the Design Wizard icon to expand the Set Up menu.
2. Locate and select the template you created in step d, then click **Open**. A new experiment is created using the setup information from the template:
   
   - Experiment properties
   - Plate setup
   - Run method
   - Reaction setup
3. (Optional) If you want to modify the experiment, use Advanced Setup (see page 100).
4. Click **Save**, enter a file name, then click **Save** to save the experiment.

---

**Notes**

---
5. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>

| Standard curve       | a. Prepare the template.           |
|                     | b. Prepare the sample dilutions.   |
|                     | c. Prepare the standard dilution series. |
|                     | d. Prepare the reaction mix.       |
|                     | e. Prepare the reaction plate.     |

| Comparative C<sub>T</sub> | a. Prepare the template. |
| Genotyping             | b. Prepare the sample dilutions. |
| Presence/absence       | c. Prepare the reaction mix.     |
|                       | d. Prepare the reaction plate.   |

6. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.

7. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click Analysis.
   c. If the data are not analyzed, click Analyze.
   d. In the navigation pane, select an analysis screen to view the data (for example, select QC Summary to view a quality summary of the data).
Appendix A Alternate Experiment Workflows
Export/Import Workflow

Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported from another experiment. Only reaction plate setup data are exported and imported.

Note: Setup data that are exported from experiments in StepOne Software v1.0 or v2.0 can be imported into experiments in StepOne Software v2.1. However, setup data that are exported from experiments in StepOne Software v2.1 cannot be imported into experiments in StepOne Software v1.0 or v2.0.

Export Setup Data

1. Double-click (StepOne software) or select Start ▶ All Programs ▶ Applied Biosystems ▶ StepOne Software ▶ <software name>
   where <software name> is the current version of the StepOne software.

2. Log in with a user name or as a Guest.

3. Open an existing experiment, or create a new experiment.
   Note: You can create a new experiment using the Design Wizard (see Chapter 2) or Advanced Setup (see page 100).

4. Select File ▶ Export.

5. Select the Export Properties tab (default), then:
   a. Select Setup.
   b. Select One File from the dropdown menu.
   c. Enter a name, then select a location for the export file.
   d. Select (*.txt) from the File Type dropdown menu.
   
   IMPORTANT! You cannot export *.xml files.

6. (Optional) Click the Customize Export tab, then select the appropriate options.

7. Click Start Export,

8. When prompted, click Close Export Tool.

Create an Experiment with an Exported Text File

You can import plate setup data from an exported text file (*.txt) to complete the reaction plate setup data for your experiment.

IMPORTANT! Be sure the exported text file you select contains only reaction plate setup data and that the experiment types match.

Notes
1. Import the reaction plate setup data from an exported text file:
   a. Using a spreadsheet application (such as Microsoft® Excel software), open an exported text file.
   b. Replace the parameters of the text file as needed. When finished, save the file as a tab-delimited text file.
   c. From the Home screen, click Advanced Setup.
      
      \textbf{Note:} If you do not see the Advanced Setup icon, click the arrow beneath the Design Wizard icon to expand the Set Up menu.
   d. Create a new experiment or open an existing experiment.
   e. Select \textbf{File} \textbf{$\Rightarrow$ Import}.
   f. Click \textbf{Browse}, locate and select the text file (*.txt), then click \textbf{Select}.
   g. Click \textbf{Start Import}. The setup data from the exported text file is imported into the open experiment.
      
      \textbf{Note:} If your experiment already contains plate setup information, the software asks if you want to replace the plate setup with the data from the text file. Click \textbf{Yes} to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 100).

3. Prepare the PCR reactions:

<table>
<thead>
<tr>
<th>Experiment Type</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Standard curve</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td></td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td></td>
<td>c. Prepare the standard dilution series.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>e. Prepare the reaction plate.</td>
</tr>
<tr>
<td>Comparative (C_T)</td>
<td>a. Prepare the template.</td>
</tr>
<tr>
<td>Genotyping</td>
<td>b. Prepare the sample dilutions.</td>
</tr>
<tr>
<td>Presence/absence</td>
<td>c. Prepare the reaction mix.</td>
</tr>
<tr>
<td></td>
<td>d. Prepare the reaction plate.</td>
</tr>
</tbody>
</table>

4. Run the experiment:
   a. Load the reaction plate into the instrument.
   b. Start the run
   c. (Optional) Monitor the run.
   d. Unload the reaction plate from the instrument.
5. Analyze the data:
   a. Open the experiment in the StepOne software.
   b. From the Experiment Menu, click **Analysis**.
   c. If the data are not analyzed, click **Analyze**.
   d. In the navigation pane, select an analysis screen to view the data (for example, select **QC Summary** to view a quality summary of the data).
Bibliography


### Advanced Setup

In the StepOne™ software, a feature that allows you to set up your experiment according to your experiment design. Advanced Setup provides you with maximum flexibility in the design and setup of your experiment.

### AIF

See assay information file (AIF).

### allele

For a given target, any of the different sequences that occurs in the population.

### allelic discrimination plot

Display of data collected during the post-PCR read. The allelic discrimination plot is a graph of the normalized reporter signal from the allele 1 probe plotted against the normalized reporter signal from the allele 2 probe.

### amplicon

A segment of DNA amplified during PCR.

### amplification

Part of the instrument run in which PCR produces amplification of the target. For quantitation experiments, fluorescence data collected during amplification are displayed in an amplification plot, and the data are used to calculate results. For genotyping or presence/absence experiments, fluorescence data collected during amplification are displayed in an amplification plot, and the data can be used for troubleshooting.

### amplification efficiency (EFF%)

Calculation of efficiency of the PCR amplification. The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to −3.23 indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:

- **Range of standard quantities** – To increase the accuracy and precision of the efficiency measurement, use a broad range of standard quantities, 5 to 6 logs (10^5 to 10^6 fold).
- **Number of standard replicates** – To increase the precision of the standard quantities and decrease the effects of pipetting inaccuracies, include replicates.
- **PCR inhibitors** – PCR inhibitors in the reaction can reduce amplification and alter measurements of the efficiency.

### amplification plot

Display of data collected during the cycling stage of PCR amplification. Can be viewed as:

- Baseline-corrected normalized reporter (ΔRn) vs. cycle
- Normalized reporter (Rn) vs. cycle
- Threshold cycle (C_T) vs. well
amplification stage  Part of the instrument run in which PCR produces amplification of the target. The amplification stage is called a cycling stage in the thermal profile and consists of denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage are displayed in an amplification plot, and the data are used to calculate results. For genotyping or presence/absence experiments, fluorescence data collected during the amplification stage are displayed in an amplification plot, and the data can be used for troubleshooting. See also cycling stage.

assay  In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers to amplify a target and a reagent to detect the amplified target.

Assay ID  Identifier assigned by Applied Biosystems to TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays.

assay information file (AIF)  Data file on a CD shipped with each assay order. The file name includes the number from the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

assay mix  PCR reaction component in Applied Biosystems TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify a target and a TaqMan® probe designed to detect amplification of the target.

AutoDelta  In the run method, a setting to increase or decrease the temperature and/or time for a step with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling stage, the settings are indicated by an icon in the thermal profile:

- AutoDelta on: ▲
- AutoDelta off: ▲

automatic baseline  An analysis setting in which the software calculates the baseline start and end values for the amplification plot. You can apply the automatic baseline setting to specific wells in the reaction plate. See also baseline.

automatic CT  An analysis setting in which the software calculates the baseline start and end values and the threshold in the amplification plot. The software uses the baseline and threshold to calculate the threshold cycle (CT). See also threshold cycle (CT).

baseline  In the amplification plot, a line fit to the fluorescence levels during the initial stages of PCR, when there is little change in fluorescence signal.
baseline-corrected normalized reporter (ΔRn)

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. In the ΔRn vs. Cycle amplification plot, ΔRn is calculated at each cycle as:

   \[ \Delta Rn \text{ (cycle)} = Rn \text{ (cycle)} - Rn \text{ (baseline)} \], where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. In the allelic discrimination plot (genotyping experiments) and the presence/absence plot (presence/absence experiments), ΔRn is calculated as:

   \[ \Delta Rn = Rn \text{ (post-PCR read)} - Rn \text{ (pre-PCR read)} \], where Rn = normalized reporter

See also normalized reporter (Rn).

biological replicate

Reactions that contain identical components and volumes, but evaluate separate samples of the same biological source (for example, samples from three different mice of the same strain, or separate extractions of the same cell line or tissue sample).

When using biological replicate groups in a comparative C_T study, the values displayed in the Biological Replicates tab are calculated by combining the results of the separate biological samples and treating this collection as a single population (that is, as one sample). For ΔC_T computations (normalizing by the endogenous control) in a singleplex experiment, the separate biological samples are treated as unpaired data when computing variability estimates of the single biological replicate. You can observe individual contributions of the separate biological samples to the single biological replicate results in the Technical Replicates tab.

**Note:** To view the Biological Replicates and Technical Replicates tabs, from the Study Menu pane, select Analysis ➤ Gene Expression.

blocked IPC

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks amplification of the internal positive control (IPC). In the StepOne™ software, the task for the IPC target in wells that contain IPC blocking agent. See also negative control-blocked IPC wells.

calibrator

See reference sample.

chemistry

See reagents.

colocated layout

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly connected to a colocated computer by the yellow cable. In this layout, you can control the instrument with the StepOne™ software on the colocated computer or with the instrument touchscreen.
**comparative \( C_T \) (\( \Delta \Delta C_T \)) method** Method for determining relative target quantity in samples. With the comparative \( C_T \) (\( \Delta \Delta C_T \)) method, the StepOne™ software measures amplification of the target and of the endogenous control in samples and in a reference sample. Measurements are normalized using the endogenous control. The software determines the relative quantity of target in each sample by comparing normalized target quantity in each sample to normalized target quantity in the reference sample.

**\( C_T \)** See threshold cycle (CT).

**custom dye** Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in experiments on the StepOne™ and StepOnePlus™ systems. When using custom dyes, the custom dye should be added to the Dye Library and a custom dye calibration performed.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

**cycle threshold** See threshold cycle (CT).

**cycling stage** In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification stage. For cycling stages, you can enable AutoDelta settings. See also amplification stage.

**data collection** A process during the instrument run in which an instrument component detects fluorescence data from each well of the reaction plate. The instrument transforms the signal to electronic data, and the data are saved in the experiment file. In the StepOne™ software, a data collection point is indicated by an icon in the thermal profile:

- Data collection on:
- Data collection off:

**delta \( R_n \) (\( \Delta R_n \))** See baseline-corrected normalized reporter (DRn).

**derivative reporter \(-R'_n\)** The negative first-derivative of the normalized fluorescence generated by the reporter during PCR amplification. In the derivative reporter \(-R'_n\) vs. temperature melt curve, the derivative reporter signal is displayed in the y-axis.

**Design Wizard** A feature in the StepOne™ software that helps you set up your experiment by guiding you through best practices as you enter your experiment design.

**diluent** A reagent used to dilute a sample or standard before adding it to the PCR reaction. The diluent can be water or buffer.

**Diluted Sample Concentration (10\( \times \) for Reaction Mix)** In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of the Reaction Setup screen. For this field, enter the sample concentration you want to use to add to the reaction mix for all samples in the experiment. “10\( \times \) for Reaction Mix” indicates that the software assumes the sample or standard component of the reaction mix is at a 10\( \times \) concentration. For example, if the diluted sample concentration is 50.0 ng/\( \mu \)L (10\( \times \)), the final sample concentration in the reaction is 5 ng/\( \mu \)L (1\( \times \)).

**dilution factor** See serial factor.
dissociation curve

See melt curve.

EFF%

See amplification efficiency (EFF%).

endogenous control

A target or gene that should be expressed at similar levels in all samples you are testing. Endogenous controls are used in relative standard curve and comparative $C_T (\Delta \Delta C_T)$ experiments to normalize fluorescence signals for the target you are quantifying. Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

When using multiple endogenous controls, the software treats all endogenous controls as a single population, and calculates the experiment-appropriate mean to establish a single value against which the target of interest is normalized. In comparative $C_T$ experiments, the mean calculated is the arithmetic mean of the $C_T$ values. In relative standard curve experiments, the $C_T$ values are converted to relative quantities prior to normalization; the mean calculated is subsequently the geometric mean of the relative quantities.

Note: Arithmetic and geometric means are related and equivalent due to logarithmic transformation of the data.

Variability estimates for multiple endogenous controls are computed separately. The final variability estimate is a pooled combination of the individual variability estimates (similar to computing pooled standard deviations).

endpoint read

See post-PCR read.

experiment

Refers to the entire process of performing a run using the StepOne™ or StepOnePlus™ systems, including setup, run, and analysis. The types of experiments you can perform using the StepOne and StepOnePlus systems:

- Quantitation - standard curve
- Quantitation - relative standard curve
- Quantitation - comparative $C_T (\Delta \Delta C_T)$
- Melt curve
- Genotyping
- Presence/absence

experiment name

Entered during experiment setup, the name that is used to identify the experiment. Experiment names cannot exceed 100 characters and cannot include any of the following characters: forward slash (/), backslash (/), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), semicolon (;), and sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex (^), left parenthesis ( ( ), right parenthesis ( ) ), or exclamation point (!).

IMPORTANT! If you run the instrument in standalone mode from the instrument touchscreen, you cannot enter more than 32 characters in the Experiment Name field and you cannot include spaces in the name.
### Glossary

#### experiment type
The type of experiment you are performing using the StepOne™ or StepOnePlus™ system:
- Standard curve
- Comparative $C_T$ ($\Delta \Delta C_T$)
- Relative standard curve
- Melt curve (not available in the Design Wizard)
- Genotyping
- Presence/absence

The experiment type you select affects the setup, run, and analysis.

#### forward primer
Oligonucleotide that flanks the 5’ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.

#### holding stage
In the thermal profile, a stage that includes one or more steps. You can add a holding stage to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

#### housekeeping gene
A gene that is involved in basic cellular functions and is constitutively expressed. Housekeeping genes can be used as endogenous controls. See also endogenous control.

#### internal positive control (IPC)
In presence/absence experiments, a short synthetic DNA template that is added to PCR reactions. You can use the IPC to distinguish between true negative results (that is, the target is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay setup, or reagent or instrument failure.

#### inventoried assays
TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays that have been previously manufactured, passed quality control specifications, and stored in inventory.

#### IPC
In presence/absence experiments, abbreviation for internal positive control (IPC). In the StepOne™ software, the task for the IPC target in wells that contain the IPC and do not contain IPC blocking agent. See also internal positive control (IPC).

#### IPC blocking agent
Reagent added to PCR reactions to block amplification of the internal positive control (IPC).

#### IPC+
See negative control-IPC wells.

#### made-to-order assays
TaqMan® Gene Expression Assays or TaqMan® SNP Genotyping Assays that are manufactured at the time of order. Only assays that pass manufacturing quality control specifications are shipped.

#### manual baseline
An analysis setting in which you enter the baseline start and end values for the amplification plot. You can apply the manual baseline setting to specific wells in the reaction plate.

#### manual $C_T$
An analysis setting in which you enter the threshold value and select whether to use automatic baseline or manual baseline values. The software uses the baseline and the threshold values to calculate the threshold cycle ($C_T$).
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>melt curve</strong></td>
<td>A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the melting temperature (Tm) of the target or can identify nonspecific PCR amplification. In the StepOne™ software, you can view the melt curve as normalized reporter (Rn) vs. temperature or as derivative reporter (−Rn′) vs. temperature. Also called dissociation curve.</td>
</tr>
<tr>
<td><strong>melt curve stage</strong></td>
<td>In the thermal profile, a stage with a temperature increment to generate a melt curve.</td>
</tr>
<tr>
<td><strong>melting temperature (Tm)</strong></td>
<td>In melt curve experiments, the temperature at which 50% of the DNA is double-stranded and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the melt curve.</td>
</tr>
<tr>
<td><strong>multicomponent plot</strong></td>
<td>A plot of the complete spectral contribution of each dye for the selected well(s) over the duration of the PCR run.</td>
</tr>
<tr>
<td><strong>negative control (NC)</strong></td>
<td>In the StepOne™ software, the task for targets or SNP assays in wells that contain water or buffer instead of sample. No amplification of the target should occur in negative control wells. Previously called no template control (NTC).</td>
</tr>
<tr>
<td><strong>negative control-blocked IPC wells</strong></td>
<td>In presence/absence experiments, wells that contain IPC blocking agent instead of sample in the PCR reaction. No amplification should occur in negative control-blocked IPC wells because the reaction contains no sample and amplification of the IPC is blocked. Previously called no amplification control (NAC).</td>
</tr>
<tr>
<td><strong>negative control-IPC wells</strong></td>
<td>In presence/absence experiments, wells that contain IPC template and buffer or water instead of sample. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample. Previously called IPC+.</td>
</tr>
<tr>
<td><strong>no amplification control (NAC)</strong></td>
<td>See negative control-blocked IPC wells.</td>
</tr>
<tr>
<td><strong>no template control (NTC)</strong></td>
<td>See negative control (NC).</td>
</tr>
<tr>
<td><strong>nonfluorescent quencher-minor groove binder (NFQ-MGB)</strong></td>
<td>Molecules that are attached to the 3’ end of TaqMan® probes. When the probe is intact, the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence signal. Because the NFQ does not fluoresce, it produces lower background signals, resulting in improved precision in quantitation. The minor groove binder (MGB) increases the melting temperature (Tm) without increasing probe length. It also allows the design of shorter probes.</td>
</tr>
<tr>
<td><strong>normalized quantity</strong></td>
<td>Quantity of target divided by the quantity of endogenous control.</td>
</tr>
<tr>
<td><strong>normalized reporter (Rn)</strong></td>
<td>Fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive reference.</td>
</tr>
<tr>
<td><strong>omit well</strong></td>
<td>An action that you perform before reanalysis to omit one or more wells from analysis. Because no algorithms are applied to omitted wells, omitted wells contain no results.</td>
</tr>
<tr>
<td><strong>outlier</strong></td>
<td>For a set of data, a datapoint that is significantly smaller or larger than the others.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>passive reference</td>
<td>A dye that produces fluorescence signal. Because the passive reference signal should be consistent across all wells, it is used to normalize the reporter dye signal to account for non-PCR related fluorescence fluctuations caused by minor well-to-well differences in concentrations or volume. Normalization to the passive reference signal allows for high data precision.</td>
</tr>
<tr>
<td>plate layout</td>
<td>An illustration of the grid of wells and assigned content in the reaction plate. In StepOne™ systems, the grid contains 6 rows and 8 columns. In StepOnePlus™ systems, the grid contains 8 rows and 12 columns. In the StepOne™ software, you can use the plate layout as a selection tool to assign well contents, to view well assignments, and to view results. The plate layout can be printed, included in a report, exported, and saved as a slide for a presentation.</td>
</tr>
<tr>
<td>point</td>
<td>One standard in a standard curve. The standard quantity for each point in the standard curve is calculated based on the starting quantity and serial factor.</td>
</tr>
<tr>
<td>positive control</td>
<td>In genotyping experiments, a DNA sample with a known genotype, homozygous or heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain a sample with a known genotype.</td>
</tr>
<tr>
<td>post-PCR read</td>
<td>Used in genotyping and presence/absence experiments, the part of the instrument run that occurs after amplification. In genotyping experiments, fluorescence data collected during the post-PCR read are displayed in the allelic discrimination plot and used to make allele calls. In presence/absence experiments, fluorescence data collected during the post-PCR read are displayed in the presence/absence plot and used to make detection calls. Also called endpoint read.</td>
</tr>
<tr>
<td>pre-PCR read</td>
<td>Used in genotyping and presence/absence experiments, the part of the instrument run that occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence data collected during the pre-PCR read can be used to normalize fluorescence data collected during the post-PCR read.</td>
</tr>
<tr>
<td>primer mix</td>
<td>PCR reaction component that contains the forward primer and reverse primer designed to amplify the target.</td>
</tr>
<tr>
<td>primer/probe mix</td>
<td>PCR reaction component that contains the primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.</td>
</tr>
<tr>
<td>pure dye</td>
<td>See custom dye and system dye.</td>
</tr>
<tr>
<td>quantitation method</td>
<td>In quantitation experiments, the method used to determine the quantity of target in the samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation methods: standard curve, relative standard curve, and comparative C_T (ΔΔC_T).</td>
</tr>
<tr>
<td>quantity</td>
<td>In quantitation experiments, the amount of target in the samples. Absolute quantity can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference between normalized quantity of target in the sample and normalized quantity of target in the reference sample.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>quencher</td>
<td>A molecule attached to the 3′ end of TaqMan® probes to prevent the reporter from emitting fluorescence signal while the probe is intact. With TaqMan® reagents, a nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher. With SYBR® Green reagents, no quencher is used.</td>
</tr>
<tr>
<td>IMPORTANT!</td>
<td>Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.</td>
</tr>
<tr>
<td>QuickStart</td>
<td>A feature in StepOne™ and StepOnePlus™ systems that allows you to run an experiment without entering plate setup information. QuickStart requires a colocated layout with the instrument powered on and an intact instrument-computer connection.</td>
</tr>
<tr>
<td>R² value</td>
<td>Regression coefficient calculated from the regression line in the standard curve. The R² value indicates the closeness of fit between the standard curve regression line and the individual C_T data points from the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.</td>
</tr>
<tr>
<td>ramp</td>
<td>The rate at which the temperature changes during the instrument run. Except for the melt curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is defined as a temperature increment. In the graphical view of the thermal profile, the ramp is indicated by a diagonal line.</td>
</tr>
<tr>
<td>ramp speed</td>
<td>Speed at which the temperature ramp occurs during the instrument run. Available ramp speeds include fast and standard.</td>
</tr>
<tr>
<td></td>
<td>• For optimal results using the fast ramp speed, Applied Biosystems recommends using fast reagents in your PCR reactions.</td>
</tr>
<tr>
<td></td>
<td>• For optimal results using the standard ramp speed, Applied Biosystems recommends using standard reagents in your PCR reactions.</td>
</tr>
<tr>
<td>IMPORTANT!</td>
<td>TaqMan Fast reagents are not supported for presence/absence experiments.</td>
</tr>
<tr>
<td>raw data plot</td>
<td>A plot of raw fluorescence signal (not normalized) for each optical filter.</td>
</tr>
<tr>
<td>reaction mix</td>
<td>A solution that contains all components to run the PCR reaction, except for the template (sample, standard, or control).</td>
</tr>
<tr>
<td>reagents</td>
<td>The PCR reaction components you are using to amplify the target and to detect amplification. Types of reagents used on the StepOne™ and StepOnePlus™ systems:</td>
</tr>
<tr>
<td></td>
<td>• TaqMan® reagents</td>
</tr>
<tr>
<td></td>
<td>• SYBR® Green reagents</td>
</tr>
<tr>
<td></td>
<td>• Other reagents</td>
</tr>
<tr>
<td>real-time PCR</td>
<td>Process of collecting fluorescence data during PCR. Data from the real-time PCR are used to calculate results for quantitation experiments or to troubleshoot results for genotyping or presence/absence experiments.</td>
</tr>
</tbody>
</table>
**reference sample**  In relative standard curve and comparative $C_T$ ($\Delta \Delta C_T$) experiments, the sample used as the basis for relative quantitation results. Also called the calibrator.

**refSNP ID**  Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called an rs number.

**regression coefficients**  Values calculated from the regression line in standard curves, including the $R^2$ value, slope, and y-intercept. You can use the regression coefficients to evaluate the quality of results from the standards. See also standard curve.

**regression line**  In standard curve and relative standard curve experiments, the best-fit line from the standard curve. Regression line formula:

$$C_T = m \log(\text{Qty}) + b$$

where $m$ is the slope, $b$ is the y-intercept, and Qty is the standard quantity. See also regression coefficients.

**reject well**  An action that the software performs during analysis to remove one or more wells from further analysis if a specific flag is applied to the well. Rejected wells contain results calculated up to the point of rejection.

**relative standard curve method**  Method for determining relative target quantity in samples. With the relative standard curve method, the StepOne™ software measures amplification of the target and of the endogenous control in samples, in a reference sample, and in a standard dilution series. Measurements are normalized using the endogenous control. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates target quantity in the samples and in the reference sample. The software determines the relative quantity of target in each sample by comparing target quantity in each sample to target quantity in the reference sample.

**Remote Monitor**  A feature in the StepOne™ software that allows you to monitor a StepOne™ or StepOnePlus™ instrument over the network. With the Remote Monitor, you can monitor the instrument status, send an experiment to the instrument, monitor amplification plots and temperature plots in real time, and download the results to your computer. You cannot operate the StepOne or StepOnePlus instrument using the Remote Monitor.

**replicate group**  A set of identical reactions in an experiment.

**replicates**  Total number of identical reactions containing identical components and identical volumes.

**reporter**  Fluorescent dye used to detect amplification. If you are using TaqMan® reagents, the reporter dye is attached to the 5′ end. If you are using SYBR® Green reagents, the reporter dye is SYBR® Green dye.

**reverse primer**  An oligonucleotide that flanks the 3′ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse transcriptase</td>
<td>An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR reaction to perform 1-step RT-PCR.</td>
</tr>
<tr>
<td>Rn</td>
<td>See normalized reporter (Rn).</td>
</tr>
<tr>
<td>ROX™ dye</td>
<td>A dye supplied by Applied Biosystems and precalibrated on the StepOne™ and StepOnePlus™ systems. ROX dye is used as the passive reference.</td>
</tr>
<tr>
<td>rs number</td>
<td>See refSNP ID.</td>
</tr>
<tr>
<td>run method</td>
<td>Definition of the reaction volume and the thermal profile for the StepOne™ or StepOnePlus™ instrument run.</td>
</tr>
<tr>
<td>sample</td>
<td>The template that you are testing.</td>
</tr>
<tr>
<td>Sample DNA (10X)</td>
<td>In the StepOne™ software, a reaction component displayed on the Reaction Mix Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is added to the reaction mix at a 10X concentration. For example, if the reaction volume is 20 μL, the calculated volume of sample for 1 reaction is 2 μL.</td>
</tr>
<tr>
<td>Sample Library</td>
<td>In the StepOne™ software, a collection of samples. The Sample Library contains the sample name and the sample color.</td>
</tr>
<tr>
<td>Sample or Standard (10X)</td>
<td>In the StepOne™ software, a reaction component displayed on the Reaction Mix Calculations tab of the Reaction Setup screen. The software assumes the sample or standard is added to the reaction mix at a 10X concentration. For example, if the reaction volume is 20 μL, the calculated volume of sample or standard for 1 reaction is 2 μL.</td>
</tr>
<tr>
<td>sample/SNP assay reaction</td>
<td>In genotyping experiments, the combination of which sample to test and which SNP assay to perform in one PCR reaction. Each PCR reaction can contain only one sample and one SNP assay.</td>
</tr>
<tr>
<td>sample/target reaction</td>
<td>In quantitation experiments, the combination of which sample to test and which target to detect and quantify in one PCR reaction. In the Design Wizard, you can detect and quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify more than one target in one PCR reaction.</td>
</tr>
<tr>
<td>serial factor</td>
<td>In the StepOne™ software, a numerical value that defines the sequence of quantities in the standard curve. The serial factor and the starting quantity are used to calculate the standard quantity for each point in the standard curve. For example, if the standard curve is defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points in the curve is 10-fold.</td>
</tr>
<tr>
<td>series</td>
<td>See standard dilution series.</td>
</tr>
<tr>
<td>slope</td>
<td>Regression coefficient calculated from the regression line in the standard curve. The slope indicates the PCR amplification efficiency for the assay. A slope of −3.32 indicates 100% amplification efficiency. See also amplification efficiency (EFF%) and regression line.</td>
</tr>
<tr>
<td>SNP</td>
<td>Abbreviation for single nucleotide polymorphism. The SNP can consist of a base difference or an insertion or deletion of one base.</td>
</tr>
</tbody>
</table>
SNP assay

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP and two probes to detect different alleles.

SNP Assay Library

In the StepOne™ software, a collection of SNP assays to add to genotyping experiments. The SNP assays in the library contain the SNP assay name, SNP assay color, and for each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in the library may also contain the assay ID and comments about the SNP assay.

spatial calibration

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the positions of the wells in the sample block(s). Spatial calibration data are used so that the software can associate increases in fluorescence during a run with specific wells in the reaction plate.

stage

In the thermal profile, a group of one or more steps. There are three types of stages: holding stage (including pre-PCR read and post-PCR read), cycling stage (also called amplification stage), and melt curve stage.

standalone layout

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to a computer by the yellow cable. In this layout, you control the instrument only with the instrument touchscreen, and you use a USB drive or network connection to transfer data between the instrument and computer.

standard

Sample that contains known standard quantities. Standard reactions are used in quantitation experiments to generate standard curves. See also standard curve and standard dilution series.

standard curve

In standard curve and relative standard curve experiments:

- The best-fit line in a plot of the Cₜ values from the standard reactions plotted against standard quantities. See also regression line.
- A set of standards containing a range of known quantities. Results from the standard curve reactions are used to generate the standard curve. The standard curve is defined by the number of points in the dilution series, the number of standard replicates, the starting quantity, and the serial factor. See also standard dilution series.

standard curve method

Method for determining absolute target quantity in samples. With the standard curve method, the StepOne™ software measures amplification of the target in samples and in a standard dilution series. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates the absolute quantity of target in the samples. See also standard and standard curve.

standard dilution series

In standard curve and relative standard curve experiments, a set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards. For example, the standard stock is used to prepare the first dilution point, the first dilution point is used to prepare the second dilution point, and so on. In the StepOne™ software, the volumes needed to prepare a standard dilution series are calculated by the number of dilution points, the number of standard replicates, the starting quantity, the serial factor, and the standard concentration in the stock. See also standard curve.
standard quantity  A known quantity in the PCR reaction.
- In standard curve experiments, the quantity of target in the standard. In the StepOne™ software, the units for standard quantity can be for mass, copy number, viral load, or other units for measuring the quantity of target.
- In relative standard curve experiments, a known quantity in the standard. Standard quantity can refer to the quantity of cDNA or the quantity of standard stock in the PCR reaction. The units are not relevant for relative standard curve experiments because they cancel out in the calculations.

starting quantity  When defining a standard curve in the StepOne™ software, corresponds to the highest or lowest quantity.

step  A component of the thermal profile. For each step in the thermal profile, you can set the ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration), and you can turn data collection on or off for the ramp or the hold parts of the step. For cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™ systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for each VeriFlex block).

study name  Entered during study setup, the name that is used to identify the study. Study names cannot exceed 100 characters and cannot include any of the following characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), semicolon (;), and sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex (^), left parenthesis ( ( ), right parenthesis ( ) ), or exclamation point (!).

SYBR® Green reagents  PCR reaction components that consist of two primers designed to amplify the target and SYBR® Green dye to detect double-stranded DNA.
**system dye**
Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or StepOnePlus™ system. Before you use system dyes in your experiments, make sure the system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne system:
- FAM™ dye
- JOE™ dye
- ROX™ dye
- SYBR® Green dye
- VIC® dye

System dyes on the StepOnePlus system:
- FAM™ dye
- JOE™ dye
- NED™ dye
- ROX™ dye
- SYBR® Green dye
- TAMRA™ dye
- VIC® dye

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

**TaqMan® reagents**
PCR reaction components that consist of primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.

**target**
The nucleic acid sequence that you want to amplify and detect.

**target color**
In the StepOne™ software, a color assigned to a target to identify the target in the plate layout and analysis plots.

**Target Library**
In the StepOne™ software, a collection of targets to add to experiments. The targets in the library contain the target name, reporter, quencher, and target color. The target in the library may also contain comments about the target.

**task**
In the StepOne™ software, the type of reaction performed in the well for the target or SNP assay. Available tasks:
- Unknown
- Negative Control
- Standard (standard curve and relative standard curve experiments)
- Positive control (genotyping experiments)
- IPC (presence/absence experiments)
- Blocked IPC (presence/absence experiments)
**technical replicate** Reactions that contain identical components and volumes, and that evaluate the same sample.

**temperature plot** In the StepOne™ software, a display of temperatures for the sample, instrument cover, and instrument block during the StepOne™ or StepOnePlus™ instrument run.

**template** In the Design Wizard of the StepOne™ software (and in QuickStart for quantitation experiments), the type of nucleic acid to add to the PCR reaction. The recommended template varies according to experiment type:

- Quantitation experiments (standard curve, relative standard curve, and comparative C_T) – cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)
  For quantitation experiments, the template type selection affects the run method, reaction setup, and materials list.
- Genotyping experiments – Wet DNA (gDNA or cDNA) or dry DNA (gDNA or cDNA)
  For genotyping experiments, the template type selection affects the reaction setup.
- Presence/absence experiments - DNA
  For presence/absence experiments, Applied Biosystems recommends adding DNA templates to the PCR reactions.

**thermal profile** Part of the run method that specifies the temperature, time, ramp, and data collection points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

**threshold**
1. In amplification plots, the level of fluorescence above the baseline and within the exponential growth region. The threshold can be determined automatically (see automatic CT) or can be set manually (see manual CT).

2. In presence/absence experiments, the level of fluorescence above which the StepOne™ software assigns a presence call.

**threshold cycle (C_T)** The PCR cycle number at which the fluorescence meets the threshold in the amplification plot.

**Tm** See melting temperature (Tm).

**touchscreen** Instrument display that you touch to control the StepOne™ or StepOnePlus™ instrument.

**unknown** In the StepOne™ software, the task for the target or SNP assay in wells that contain the sample you are testing:

- In quantitation experiments, the task for the target in wells that contain a sample with unknown target quantities.
- In genotyping experiments, the task for the SNP assay in wells that contain a sample with an unknown genotype.
- In presence/absence experiments, the task for the target in wells that contain a sample in which the presence of the target is not known.

**unknown-IPC wells** In presence/absence experiments, wells that contain a sample and internal positive control (IPC).
**VeriFlex™ Technology**

The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex™ blocks, creating up to six different zones for the 96 sample wells. After you enable the VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or more of the VeriFlex blocks.

**y-intercept**

In the standard curve, the value of y where the regression line crosses the y-axis. The y-intercept indicates the expected threshold cycle (C_T) for a sample with quantity equal to 1.

**zone**

One of up to six sample temperatures among the 96 wells formed by independently thermally regulated VeriFlex™ blocks during the StepOnePlus™ instrument run. You can set a different temperature for one or more of the VeriFlex blocks, or you can set the same temperature for each of the VeriFlex blocks.

**Note:** For melt curve steps, you need to set the same temperature for each of the VeriFlex blocks.

**zone boundary**

The edge of a zone for samples formed by the six independently thermally regulated VeriFlex™ blocks. In the StepOne™ software, the zone boundaries are displayed in the plate layout as thick red lines.
Index

Numerics

5′ Nuclease Assay 7

A

Advanced Setup 9, 10, 100
allele calling
automatic 96
manual 97
Allelic Discrimination Plot 8, 73
assign calls manually 97
evaluate the results 73–75
alternate experiment workflows. See workflows.
amplification
NOAMP flag 79
view after a run 86–91
Amplification Plot 86
view after a run 86–92
Amplification Plot screen
monitor during a run 59
amplification plot, typical 88
AMPNC flag 79
analysis guidelines 75, 77, 80, 82, 83, 85, 88, 95
analysis screens
Allelic Discrimination Plot 73–75
Amplification Plot 86–91
Multicomponent Plot 84–85
Multiple Plots View 92
plate layout 76–77
QC Summary screen 81–82
Raw Data Plot 82–83
well table 78–80
analysis settings 93–95
analyze experiment. Also see troubleshooting.
analyze 70
export data 98
guidelines 75, 77, 80, 82, 83, 85, 88, 95
print data 98
view Allelic Discrimination Plot 73
view Amplification Plot 86
view analysis settings 93
view Multicomponent Plot 84
view plate layout 76
view QC summary 81
view Raw Data Plot 82
view well table 78
workflow 70
Applied Biosystems
contacting xi
customer feedback on documentation xi
Technical Support xi
Applied Biosystems StepOne Real-Time PCR System.
See StepOne system.
assay information file (AIF) 23
assay mix 40
assumptions for using this guide vi
automatic allele calling 96

B

BADROX flag 79, 81
baseline
about 88
adjusting 93
correct values 89
examples 91
biohazardous waste, handling xix
BLFAIL flag 80

C

CAUTION, description xii
chemical safety xvii
chemical waste safety xviii
CLUSTER flag 79
colocated layout
data transfer 66
monitoring 58
startup 54
consumables 32, 39, 40, 42
Also see materials required 4
supported 4
control
negative 25, 26, 75, 76, 85
positive 25, 26, 75
conventions used in this guide vi
create an experiment
type example experiment 17
export 98
print 30, 98
CTFAIL flag 80
customer feedback, on Applied Biosystems
documents xi

D

DANGER, description xii
data
Index

about data collection 2
example experiment 9, 71
transfer 65
design experiment
create new 17
define experiment properties 19
define methods and materials 21
finish design wizard 35
for more information 36
guidelines 20, 22, 24, 26, 28, 31, 34, 36
order materials 32
set up reactions 29
set up run method 27
set up samples and replicates 25
set up SNP assays 23
workflow 16
design wizard 13
Experiment Properties screen 19
finish 35
Materials List screen 32
Methods and Materials screen 21
Reaction Setup screen 29
Run Method screen 27
Samples and Replicates screen 25
SNP Assays screen 23
development, standard 90
documentation, related vii

E
electrical safety xix
electromagnetic compatibility standards. See EMC standards
EMC standards xxi
equipment operation, safety xvi
example experiment
analyze 70
data 73, 76, 78, 81, 82, 84, 86, 93
data location 11
description 10
design 16, 21, 23, 25, 27, 29
plate layout 11
prepare 38
prepare reactions 38
run 48
workflow 13
Experiment Properties screen 19
EXPFAIL flag 80
export data 98
Export/Import 10, 105

F
flag
AMPNC 79
BADROX 79
BLFAIL 80
CLUSTR 79
CTFAIL 80
EXPFAIL 80
NOAMP 79
NOISE 79
NOSIGNAL 79
OFFSCALE 79
PCFAIL 79
SMCLUSTER 79
SPIKE 79
THOLDFAIL 80
flags 79, 81
fluorescence
NOISE flag 79
NOSIGNAL flag 79
OFFSCALE flag 79
SPIKE flag 79

G
General xx
guidelines
analysis 75, 77, 80, 82, 83, 85, 88, 95
chemical safety xvii
chemical waste disposal xviii
chemical waste safety xviii
design 20, 22, 24, 26, 28, 31, 34, 36
preparation 39, 41, 43
run 53

H
hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
hazards. See safety
Help system, accessing x

I
installation category xx
instrument operation, safety xvi

L
load reaction plate 42, 50

M
manual allele calling 97
Materials List screen 32
materials required 32, 39, 40, 42
Methods and Materials screen 21
monitor run
Amplification Plot screen 59
colocated layout 58
Run Method screen 61
standalone layout 64
standalone layout (remote) 62
Temperature Plot screen 60
moving and lifting, safety xvi
MSDSs
  description xvii
  obtaining xvii
MSDSs, obtaining xi
Multicomponent Plot 84
multiple plots, viewing 92

N
negative control 76, 85
  AMPNC flag 79
  apply 25, 26
  confirm 75, 78
no signal flag 79
NOAMP flag 79
NOISE flag 79
non-specific fluorescence 8
NOSIGNAL flag 79
notification settings 51

O
OFFSCALE flag 79
omit wells 78, 80
online Help. See Help system
other fluorescent-based reagents 9
overvoltage category (rating) xx

P
passive reference
  BADROX flag 79
PCFAIL flag 79
plate layout 76
plus/minus assay
  result calls 92
positive control
  apply 25, 26
  confirm 75, 78, 80
  PCFAIL flag 79
preparation guidelines 39, 41, 43
prepare experiment
  for more information 38
  guidelines 39, 41, 43
  reaction mix 40
  reaction plate 42
  sample dilutions 39
  workflow 38
prepare for run 38, 49
print data 98

Q
QC Summary screen 81
QuickStart 10, 101
R
radioactive waste, handling xix
ramp speed 22
Raw Data Plot 82
reaction mix
  order 32
  prepare 40
  set up 29
reaction plate
  load 50
  order 32
  prepare 42
  unload from the instrument 65
Reaction Setup screen 29
reagents
  order 32
  other fluorescent-based 9
  supported 9
  TaqMan® reagents 6–8, 21
repetitive motion, safety xxi
results
  assigning calls automatically 96
  assigning calls manually 97
results, interpreting 70
run experiment
  alerts 61
  enable notification settings 51
  for more information 51, 61, 62
  guidelines 53
  monitor 58
  prepare for 49
  start 54
  transfer data 65
  workflow 48
run method
  set up 27
Run Method screen 27
  monitor during a run 61

S
safety
  before operating the instrument xvi
  biological hazards xx
  chemical xvii
  chemical waste xviii
  conventions xii
  electrical xix
  ergonomic xxi
  guidelines xvii, xviii, xix
  instrument operation xvi
  moving and lifting instrument xvi
  moving/lifting xvi
  repetitive motion xxi
  standards xxi
workstation xxi
safety labels, on instruments xv
safety standards xxi
safety symbols, on instruments xiv
Samples and Replicates screen 25
select wells 77
single-nucleotide polymorphism 6
SMCLUSTER flag 79
SNP assay 6
SNP Assays screen 23
SPIKE flag 79
standalone layout
data transfer 67
monitoring 64
remote data transfer 66
Remote Monitor 62
startup 55
standard deviation, effect of threshold on 90
standards
EMC xxi
safety xxi
start run
colocated layout 54
standalone layout 55
StepOne system
consumables 4
data collection 2
filters 3, 83
layouts 54, 58, 65
StepOne™ system
reagents 6
SYBR Green reagents 3, 83
symbols, safety xiv
T
TaqMan reagents 3, 83
TaqMan® MGB Probes 6
TaqMan® SNP Genotyping Assays 6
Technical Support, contacting xi
Temperature Plot screen 60
Template 10, 103
template, preparation 39
text conventions vi
THOLDFAIL flag 80
threshold
correct values 89
examples 90
threshold, adjusting 93
training, information on xi
transfer data 65
troubleshooting
adjust baseline 93
adjust threshold 93
flags 79
view Amplification Plot 86
view analysis settings 93
view Multicomponent Plot 84
view QC Summary 81
view Raw Data Plot 82
U
unknown samples 25, 76
unload instrument 65
user attention words, described vii
using this guide
as a tutorial 9
with your own experiments 9
W
WARNING, description xii
waste disposal, guidelines xix
waste profiles, description xix
well table 78
wells
negative control 25, 76
plate layout 76
positive control 25, 76
selecting 77
unknown 76
unknowns 25
well table 78
workflow
Design Wizard 13
workflows
Advanced Setup 100
Export/Import 10, 105
QuickStart 10, 101
Template 10, 103
workstation safety xxi
Worldwide Sales and Support

Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at www.appliedbiosystems.com.

Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (In North America): +1 800.345.5224
Fax: +1 650.638.5884

12/2008